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To learn how to use Help, press F1.

 Using Image Editor
A complete guide to Image Editor with step-by-step instructions

 Reference Information
Thorough explanations of Image Editor components

 Programming with ImagePals
Information about the Ulead ADK and how to order it

Technical Support
How to contact Ulead Systems if you have questions
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Quick access to on-line help for all the other ImagePals Programs
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Tips & Techniques
Glossary



Menu Commands
File Menu
Edit Menu
Image Menu
Effect Menu
View Menu
Window Menu
Help Menu
Pals Menu

Related topic

Window Control Menu



    File Menu

New

Open
Restore
Close
Save

Save As

Batch Manager
Acquire
Source
Import
Export

Print
Printer Setup
Preferences
Exit
Recent Files List



    Source Submenu
Contains command to select a TWAIN data source or proprietary scanner device driver, automatically 
adjust an image and/or access image enhancement after input. Three of these commands automatically 
opens a dialog box after scanning.

Select

Auto Tone Adjustment
Brightness & Contrast
Tone Adjustment
Tone Mapper
Scan to Printer



    Preferences Submenu
Contains commands to customize several features of Image Editor.

Image Editor

OLE & Clipboard

PhotoCD

Display

Memory

File Formats



    Edit Menu
Undo
Cut
Copy
Paste
Clear
Clipboard
Select

Crop

Fill

Stitch

Tile Two Images



    Paste Submenu
Contains two commands to place the contents of the clipboard into an image.

As Selection
Into Selection



    Clipboard Submenu
Contains commands to load, save, and display images on the clipboard.

Load

Save
Display



    Select Submenu
Contains commands to manage selection areas.

None
All
Invert

Border

Similar
Make Floating
Discard Floating

Merge Control

Load Mask

Save Mask



    Image Menu

Tone Mapper

Tone Adjustment

Brightness & Contrast

Hue & Saturation
Invert

Level Adjustment
Optimize
Convert
Duplicate

Resolution

Resample



    Convert Submenu
Contains commands to convert image data types.

Black & White

Grayscale
Indexed 16-Color

Indexed 256-Color
RGB True Color

Note: It is possible to convert any data type to any other but a direct conversion may not be available. 
When there is no direct conversion available, the target data type is grayed out in the Convert submenu. 
In these cases, you first have to convert your image to RGB True Color or Grayscale and then to your 
target type.

Related topic

Converting images



Converting to Indexed 16-Color

When you convert to Indexed 16-Color, depending on the data type of the active image, Image Editor 
provides different options:

From Grayscale

From RGB True Color

Related topic

Converting images



    Effect Menu
Blur
Sharpen
Despeckle
Emphasize Edges
Find Edges
Adjust for NTSC

Special Effects

Warping

Custom Filter
Free Resize
Flip
Rotate
Slant
Distort
Set as Wallpaper



    Rotate Submenu
Contains commands to rotate the active image or selected area to any angle and direction

Left 90 degrees
Right 90 degrees
180 degrees
Freely

Degree
By Horizontal line
By Vertical line

Related topic

Rotating images



    View Menu
Add a View
Actual View
Zoom In
Zoom Out
Fit in Window
Full Screen
Image Information
System Information

Color Table
Option



    Option Submenu
Contains commands to hide or show features of Image Editor

Hide/Show Toolbar

Hide/Show Color Palette
Hide/Show Status Bar

Hide/Show Global Viewer

Hide/Show Object Pool
Hide/Show Rulers



    Window Menu
Cascade
Tile
Arrange   Icons  
Windows List



    Help Menu
Contents
Search for Help on
How to Use Help
About Ulead Products
About Image Editor



    Pals Menu

This menu contains the names of the other ImagePals programs. Click on a name and the 
corresponding program is invoked. You can also access the Windows Program Manager, File Manager 
and Clipboard Viewer (if available).



    Window Control Menu

Every window has its own control menu in the top left corner to manage the window itself. Some control 
menus also contain an additional command such as Next or Run. These commands allow you to swap 
between windows.

Restore restores a window to its normal size (i.e. the size it was before being maximized or 
minimized)

Move allows you to move the window
Size allows you to change the size of the window
Minimize reduces the window to an icon
Maximize enlarges the window to fill all available space (either on screen or within a parent 

window)
Close closes the window
Switch To brings up the Windows Task List dialog box



Toolbar

Magic Wand

Freehand Selection

Rectangular Selection

Elliptical Selection

Move Selection

Eyedropper

Zoom

Magic Lamp

Paintbrush

Clone

Airbrush

Line

Eraser

Text



Color Palette

Brush Settings

Color Panel

Color indicators

Color Value sliders



Global Viewer

The Global Viewer is useful to view images too large to fit in a window. You can display it with the 
Show/Hide Global Viewer command in the View: Options menu.

The highlighted rectangular area in the Global Viewer shows the visible part of the image. Drag this area 
to view other parts of the image. Double-click on the Global Viewer window to fit the image in a window.

When a window has vertical and horizontal scroll bars, you can press the square button at the 
intersection of the scroll bars to display the Global Viewer. The Viewer disappears when you release the 
mouse button.
Note: Double-click on the Global Viewer title bar to hide it.



Status Bar

The Image Editor status bar runs along the bottom of the workspace.

The button at the left of the status bar displays a pop-up menu similar to the View: Options submenu and 
allows you to show or hide the major elements of Image Editor.

The first field shows the position of the mouse pointer on an image, and the RGB or HSB values (as 
chosen in the Select Color dialog box) of the pixels in the current pointer position on an image or the 
Color palette.

The second field displays information either about the active image and your system, or a particular 
feature, if you place your mouse pointer on the Toolbar, the Color palette, or select a menu command.
Note: Double-click on the status bar to display the Preferences: Image Editor dialog box.

Related topic
Select Color dialog box



Object Pool

The Object Pool allows you to drag selection areas to a group you create. Selections are stored as 
images or masks. Once stored, each image or mask appears as a thumbnail in the Object Pool, and is 
called an object.

To display the Object Pool, double-click on the Object Pool icon below the Color palette, or choose 
Hide/Show Object Pool from the View: Options submenu, or status bar pop-up menu.
You can drag selection directly to the icon to store objects. Click on the arrow button to display the Object 
Type menu where you can choose how to store your selections. The status bar indicates which group is 
active.
Note: Double-click on the Object Pool title bar to close it.

The Object Pool Window
Dragging a selection into the Object Pool
Dragging an object from the Object Pool



Object Pool Window

Click on this button to choose how to store a selection
Group list box displays all the existing groups

Press this button to display only masks in the group

Press this button to display only images in the group

Press this button to manage groups

Press this button to make a group read-only

Related topic

Object Pool



Shortcuts

Image Editor has many shortcuts that allow you to access commands and open dialog boxes without 
going through the menus. Some shortcuts use key commands and others use the mouse.

Click here to print this topic
Click here to close this window

File Menu

Ctrl + O Displays the Open dialog box

Ctrl + S Saves the active image file

Ctrl + P Displays the Print dialog box

Ctrl + Q Exits Image Editor

F5 Toggles "Preserve Image Under Selection" in Preferences dialog box

F6 Displays the Preferences: Image Editor dialog box
Edit Menu

Ctrl + Z Undoes the last command

Ctrl + X Cuts active image or selection onto the clipboard

Ctrl + C Copies active image or selection onto the clipboard

Ctrl + V Pastes data from the clipboard as selection

Del Replaces active image or selection with background color

(If Object Pool is active, deletes the selected objects)

Ctrl + L Selects the whole image

Ctrl + N Deselects a selection

F3 Discards a floating selection

F4 Displays the Merge Control dialog box

Ctrl + R Crops the edges of the selection area

Ctrl + F Displays the Fill dialog box

Ctrl + T Displays the Stitch dialog box
Image Menu

Ctrl + J Displays the Tone Adjustment dialog box

Ctrl + B Displays the Brightness & Contrast dialog box

Ctrl + H Displays the Hue & Saturation dialog box

F7 Inverts color and brightness values in the active image

F8 Displays the Level Adjustment dialog box

F9 Optimizes the gray/color values in the active image

Ctrl + D Duplicates the active image window

Ctrl + M Displays the Resample dialog box
Effect Menu

Ctrl + E Displays the Special Effects dialog box

Ctrl + G Displays the Rotate dialog box
View Menu

Ctrl + I Adds a view of the active image

Ctrl + A Shows the actual view of the image



Ctrl + W Sets Full Screen viewing mode

+ Zooms in on the active image

- Zooms out on the active image
Window Menu

Shift + F5 Cascades all image windows

Shift + F4 Tiles all image windows
Help Menu

F1 Opens Image Editor Help

Shift + F10 Displays Microsoft Windows Help
Double clicking on Toolbar Icons

Magic Wand Displays the Magic Wand dialog box

Freehand Deselects any selected area

Rectangular Displays the Select Area dialog box

Elliptical Displays the Select Area dialog box

Eyedropper Displays the Select Color dialog box

Zoom Sets the active image to Actual View

Magic Lamp Displays the Magic Lamp dialog box

Paintbrush Displays the Paintbrush dialog box

Clone Displays the Clone dialog box

Airbrush Displays the Airbrush dialog box

Line Displays the Line dialog box

Eraser Displays the Eraser dialog box

Text Displays the Text dialog box
Mouse Actions

Click right mouse button Brings up the Select submenu

Double-click title bar Maximizes or restores the active window

Double-click workspace Displays the Batch Manager dialog box

Double-click status bar Displays the Image Editor dialog box

Double-click Global Viewer Fits the image in a window
Miscellaneous

Esc Switches from full screen to normal viewing mode

Esc Closes a dialog box without making changes

Esc Terminates the Gradient Fill mode

Shift Preserves the aspect ratio when resizing

Shift Sets reference points when stitching images

Shift Drags only one corner when slanting selection areas

Shift Drags a corner without applying effect when distorting selection areas

Shift Adds selection to existing selection areas

Shift Zooms out with the Zoom tool

Shift Sets the reference point when cloning

Shift Limits line angles to horizontal, vertical and diagonal when using the Line tool

Shift Use with Preview button to re-enable live preview with image enhancement 
command



Ctrl Substracts selection to existing selection areas

Ctrl + Tab Makes another image in the workspace the active image
Command Line options

/n or -n Do not display the ImagePals logo when opening Image Editor
Drag-and-drop operations

Drag files from Windows File Manager (to Image Editor workspace or icon) to open the image

Drag a selection

to an image, it appears as a floating selection

to the workspace, it appears in an untitled window

to the Object Pool to store it as image or mask

Drag an image object from the Object Pool

to an image, it appears as a floating selection

to the workspace, it appears in an untitled window

Drag a mask object from the Object Pool

to an image, it appears as a static mask

to the workspace, it appears in a grayscale untitled window

Drag a selection holding down the "M" key

to the Object Pool, it is stored as a mask object

to an image, it appears as a static mask

to the workspace, it appears in a grayscale untitled window

Drag a selection, or an image object from the Object Pool, holding down the "F" key

to an image to create a pattern fill



 Other ImagePals Program Helps

 Album

 Screen Capture

 Viewer

 CD Browser



New

Data Type defines the data type of the new image
Image Size defines the size of the image to be created
Resolution defines the number of pixels in the image when the size is in centimeters or inches

Related topic

Creating a new image



Open

File Name shows the selected file extension; enter the filename you wish to open or select a 
filename from the list box

List Files of Type shows all the available file formats for image and graphic files
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Browse opens the Browse dialog box, use this dialog box to search for files
Options opens the open options dialog boxes for file formats that provide options
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)
Preview displays the contents of the selected file
Info Area gives information on the file selected in the files list box

Related topic

Opening an image



Select Source

Sources lists all the available TWAIN data source or proprietary scanner device driver
OK closes the dialog box and saves your selection

Related topic

Inputting images



Save As

File Name allows you to enter a filename or, if you wish to overwrite an existing file, select its 
filename from the files list box

List Files of Type lists the available file formats and their extensions
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Options opens the save options dialog boxes for file formats that provide options
Browse opens the Browse dialog box, use this dialog box to search for files
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)
Save to Album allows you to choose whether or not to save a thumbnail of the file to Album
Album opens the Insert Thumbnails into Album dialog box. Use this to place files into albums in 

Album's workspace or into a newly created album

Related topic

Saving an image



Batch Manager

Operation lists all the commands that can be applied to multiple images
Images displays the filenames of images in the workspace
Select All selects all the images in the workspace
Deselect deselects any selected images

Note: Double-clicking anywhere in the workspace displays the Batch Manager dialog box.

Related topics

Using the Batch Manager
Save dialog box
Print dialog box
Resolution dialog box
Windows Control Menu



Print

Printer shows the currently selected printer (selected in the Printer Setup dialog box)
Copies allows you to enter the number of copies to print
Scale to Fit the Page scales images to print as large as possible on the output page
Center Image Horizontally and Vertically allow you to choose where the image prints on the 

output page
Start From Top Left Corner determines the exact positioning of an image on the output page
Perform Halftone by Printer lets the printer define the halftone (depends on your printer)
Set Halftoning defines the halftone screen variables for monochrome and color images
Tone Map calibrates the image data to the particular characteristics of the printer

Related topic

Printing an image



Halftone

High Contrast ,if checked, performs no halftoning: gray shades are converted directly to black or 
white

Shape determines the basic shape of the black "dot" used to construct the halftone
Angle defines the angle at which the dots occur
Frequency determines the distance between the centers of the halftone dots

Related topic

Print dialog box



Image Editor

Unit of Measure allows you to choose the unit of measure from pixels, inches, or centimeters
Preserve Image Under Selection preserves the underlying image when you move a selected 

area
Enable Undo enables the Undo command in the Edit menu
Background Color in Thumbnails chooses the background color for the thumbnails which 

appear in the Object Pool and some dialog boxes (Special Effect, Warping,...)
Number of File Names Kept specifies the number of files, which can be opened directly, listed at 

the bottom of the File menu



OLE & Clipboard

Include OLE Related Formats if unchecked, disables the Paste Link command in the client 
application

Device Dependent Bitmap (DDB) if unchecked, saves memory if you know that the client 
application does not need to retrieve the DDB format from the clipboard (Image Editor always copies DIB 
to the clipboard)

Convert DIB as Display Mode converts a true color image copied to the clipboard to 256-Color
Delay Render if unchecked, sends data to the clipboard immediately when the Edit: Copy or Cut 

command is used



Display

HiColor Dithering improves the display of RGB True Color images on HiColor displays
View Images with a Common Palette displays all images on a 256-Color display using the 

system palette
Don't Care About Background Quality causes only the active image to be displayed as well as 

possible
Monitor Gamma allows you to adjust the display of images to accommodate for differences in 

working environments
VGA Palette enables you to adjust the display of images on 16-Color displays



VGA Palette

Bypass VGA Palette to Enable Use of 16 Grays causes Grayscale images to be displayed with 
16 grays and makes the Display thumbnails in Grayscale option (in the New Album dialog box) available

Compatibility Test tests to see if your display card is compatible with this feature

Related topic

Display dialog box



Memory

1. shows your current TEMP directory defined in your AUTOEXEC.BAT file. If you do not have a 
TEMP variable defined, then the Windows pre-defined directory appears.

2.3.4. allow you to enter additional drives and directories which will provide extra working space 
(normally different drives unless your access rights to particular directories allow you different space 
allocations on the same drive)



Save Clipboard File

File Name allows you to enter a filename or, if you wish to overwrite an existing file, select its 
filename from the files list box

List Files of Type lists the available file formats and their extensions
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Options opens the save options dialog boxes for file formats that provide options
Browse opens the Browse dialog box, use this dialog box to search for files
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)
Save to Album allows you to choose whether or not to save a thumbnail of the image to Album
Album opens the Insert Thumbnails into Album dialog box. Use this to place files into albums in 

Album's workspace or into a newly created album



Load File to Clipboard

File Name initially shows all the available extensions; if you know the path and name of the file 
you wish to load, enter it here or select it from the list box

List Files of Type lists the file extensions of images that Image Editor can open
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Directories shows the directories available in the current directory, and all available drives
Options opens the open options dialog boxes for file formats that provide options
Browse opens the Browse dialog box, use this dialog box to search for images you want placed 

onto the clipboard
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)
Preview displays the contents of the selected file
Info Area gives information on the file selected in the files list box



Border

Border Width defines the width of the border to be selected
Preview allows you to preview the current settings without leaving the dialog box



Similar

Color Similarity defines the range of similar gray/color values that will be included in the current 
selection

Expand From Current Selection, if checked, expands the current selection to include only areas 
that are connected to the original selection

Preview allows you to preview the current settings without leaving the dialog box



Merge Control

Factor provides options to control which channels of the floating selection are merged
Transparency defines the transparency of the floating selection
Edge Blending controls the way the edge of the floating selection merges
OK closes the dialog box and applies settings to the floating selection
Preview allows you to preview the current settings without closing the dialog box

Related topic

Merging a selection areas.



Load Mask

File Name initially shows all the available extensions; if you know the path and name of the file 
you wish to load, enter it here or select it from the list box

List Files of Type lists the file extensions of images that Image Editor can open
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Directories shows the directories available in the current directory, and all available drives
Options opens the open options dialog boxes for file formats that provide options
Browse opens the Browse dialog box, use this dialog box to search for images you want placed 

onto the clipboard
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)
Preview displays the contents of the selected file
Info Area gives information on the file selected in the files list box

Related topic

Working with masks



Save Mask

File Name allows you to enter a filename for the mask or, if you wish to overwrite an existing file, 
select its filename from the files list box

List Files of Type lists the available file formats and their extensions (choose a file format which 
accept Grayscale images as masks are save as Grayscale images)

Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Options opens the save options dialog boxes for file formats that provide options
Browse opens the Browse dialog box, use this dialog box to search for files
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)
Save to Album allows you to choose whether or not to save a thumbnail of the file to Album
Album opens the Insert Thumbnails into Album dialog box. Use this to place files into albums in 

Album's workspace or into a newly created album

Related topic

Working with masks



 Fill

Foreground and Background Color uses the foreground or background color shown in the 
current colors indicator

Black uses black as the fill color
White uses white as the fill color
Clipboard Data fills the area or image with repeated data from the clipboard like a pattern
Start From Selection causes the clipboard data to be pasted in starting from the selection area's 

top left corner
Foreground to Background Color creates a transition from the foreground color to the 

background color
Background to Foreground Color creates a transition from the background color to the 

foreground color

Gradient Fill Style group box allows you to select the shape of the fill
Linear creates a fill along a straight line
Rectangle and Elliptical fills radiate outward from the center of a particular shape

Related topic

Selecting colors



 Tile Two Images

Floating Image allows you to choose the image to join to the active image
Direction allows you to choose the position to place the floating image relative to the active 

image by clicking on the arrows (the floating image is shown with a shadow)
Distance from the edge of the active image to the edge of the floating image
Transparency defines the transparency of the floating image in any area of overlap
OK joins the two images and displays the new, composite image in an untitled window

Related topic

Joining images using the Tile Two Images command



Stitch

Floating Image allows you to choose the image to join to the active image
Direction allows you to choose where to place the floating image relative to the active image by 

clicking on an arrow (the floating image is shown with a shadow)
Place puts Image Editor into Stitch mode with the active and floating images to be stitched

Related topic

Joining images using the Stitch command



 Auto Stitch Control

Horizontal/Vertical Tolerance defines how much the floating image needs to move along the 
edge to be stitched

Overlap Range defines how much the images need to overlap to match accurately
OK closes the dialog box and moves the floating image to match the underlying image

Related topics

Stitch mode
Stitch options



 Transparency

Floating Image Transparency defines the transparency of the floating image in the area of 
overlap

Related topics

Stitch mode
Stitch options



Tone Mapper

Map displays the values of the darkest pixels on the left and the brightest values on the right
Enhance lists several pre-defined mapping curves or functions
Channel allows you to specify which channels to edit
Smooth smoothes the mapping curve and the range of gray/color values associated with it
Load a previously saved map file into the active image
Save the active image's map file for use in another image
Preview allows you to preview the current settings without leaving the dialog box (this button 

does not appear if you access the Tone Mapper dialog box from the Print dialog box)
Show Control Points adds handles to the mapping curve
Accumulatively allows you to apply a new mapping curve without losing the changes of the 

precedent curve

Related topic

Print dialog box



Load Tone Map

File Name initially shows the MAP extension; if you know the path and name of the map file you 
wish to load, enter it here or select it from the list box

List Files of Type lists the file extensions for map files (MAP)
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Browse opens the Browse dialog box, use this dialog box to search for map file
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)

Related topic

Tone Mapper dialog box



Save Tone Map

File Name initially shows the MAP extension; enter a filename, or if you wish to overwrite an 
existing map file, select its filename from the list box below

List Files of Type lists the file extensions for map files
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)

Related topic

Tone Mapper dialog box



Tone Adjustment

Histogram displays the number of pixels in the active image with different pixel values (colors)
Highlight enables you to increase or decrease the highlights in an image
Midtone adjusts the midtones (gamma) of an image
Shadow enables you to adjust shadow areas in an image
Histogram Scale Factor zooms in on the histogram, magnifying the number of pixels with 

particular values
Channel allows you to specify which channels to edit
Auto remaps the pixels so that they use the full range of tones available
Preview allows you to preview the current settings without leaving the dialog box

Related topic

Adjusting image values



 Brightness & Contrast

Brightness controls the lightness or darkness of an image. The lower the value, the darker your 
image becomes

Contrast controls the difference between light and dark pixels. A very low contrast makes colors 
tend towards a midtone gray

Channel allows you to specify which channels of an RGB True Color image to adjust
Preview allows you to preview the current settings without leaving the dialog box

Related topic

Adjusting image values



 Hue & Saturation

Hue allows you to adjust the color of an RGB True Color image
Saturation allows you to adjust the intensity of the active image
Preview allows you to preview the current settings without leaving the dialog box

Related topic

Adjusting image values



 Level Adjustment

Levels per Channel specifies the number of gray/color values that the current number will be 
reduced to

Channel allows you to specify which channels of an RGB True Color image to adjust
Preview allows you to preview the current settings without leaving the dialog box

Related topic

Adjusting image values



Auto Tone Adjustment

Adjust Value specifies how much the midtones of the scanned image will be adjusted



Resolution

Current Resolution shows the resolution of the active image
Display sets the resolution to be the same as your display
Printer sets the resolution to be the same as your currently selected printer (selected in the 

Printer Setup dialog box)
User Defined allows you to define your own resolution

Related topics

Changing the resolution of an image
Batch Manager dialog box



 Resample

Active Image shows the width, height and resolution of the active image
Keep Aspect Ratio determines if the image is resized retaining the proportion of the original
New Image allows you to enter the width and height for the new image.

Related topic

Resampling an image



Special Effects

Effect lists the following special effects:
Average
Blast
Cool
Emboss
Facet
Fat/Thin
Fish Eye
Mosaic
Motion Blur
Puzzle
Stagger
Tile
Warm
Watercolor
Windy
Factor provides controls to adjust the intensity of the effects
Sample Images show the action performed by the effect
Preview allows you to preview the result of the chosen effect on the active image without leaving 

the dialog box



Warping

Sample window displays the selected image or area with the warping grid
Reset restores the original grid after modification
Show Control Points when checked displays the control points at the intersection of the grid 

lines
Grid Size allows you to choose the size of the grid
Testing lets you see the warping effect on a thumbnail of the image
Quality Control allows you to choose the quality of the effect
Preview allows you to preview the settings on the active image without closing the dialog box



Custom Filter

Matrix represents the cell of pixels from which the value of each pixel in an image is generated
Reset resets the cell values to 0, the center value to 1
Symmetry allows you to choose options that speed up the entering of values in the matrix
Testing lets you see the effect of the filter on a thumbnail of the image
Divided by sets the value by which the sum of the values generated from the matrix is divided by
Offset sets the value that is added to the result of the above division
Invert inverts the gray/color values in the image or selected area
Load allows you to load a previously saved filter
Save allows you to save a filter for future use
Preview allows you to preview the effect of the current settings on the active image without 

closing the dialog box

Related topic

Creating customized filters



Load Custom Filter

File Name initially shows the ULF extension; if you know the path and name of the filter file you 
wish to load, enter it here or select it from the list box

List Files of Type lists the file extensions for filter files (ULF)
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Browse opens the Browse dialog box. Use this dialog box to search for a filter file
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)

Related topic

Custom Filter dialog box



Save Custom Filter

File Name initially shows the ULF extension; enter a filename, or if you wish to overwrite an 
existing filter file, select its filename from the list box

List Files of Type lists the file extensions for filter files
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)

Related topic

Custom Filter dialog box



Rotate

Degree is the amount the image or selected area is rotated
Direction is the direction in which the image or selected area is rotated

Related topic

Rotating images



Color Table

Color Squares click on a color square to change its color
Load a previously saved color table into the active image
Save the active image's color table for use in another image

Related topic

Select Color dialog box



Load Color Table

File Name initially shows the PAL extension; if you know the path and filename of the color table 
you wish to load, enter it here or select it from the list box

List Files of Type lists the file extension for color tables
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Browse opens the Browse dialog box, use this dialog box to search for color tables
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)

Related topic

Color Table dialog box



Save Color Table

File Name initially shows the PAL extension; enter a filename, or if you wish to overwrite an 
existing color table, select its filename from the files list box

List Files of Type lists the file extension of color tables
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Browse opens the Browse dialog box, use this dialog box to search for a directory containing 

related files
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)

Related topic

Color Table dialog box



Magic Wand

Color Similarity defines the range of grays or colors that are selected in the image

Related topics

Magic Wand tool
Working with selection area



Select Area (Rectangular Selection)

Draw From Center defines a selection area from the center outward
Select Square defines the selection area to a square
Freehand allows you to select an area of any size
Fixed Size selects an area of pre-defined width and height

Related topics

Rectangular Selection tool
Working with selection area



Select Area (Elliptical Selection)

Draw From Center defines a selection area from the center outward
Select Circle defines the selection area to a circle
Freehand allows you to select an area of any size
Fixed Size selects an area of pre-defined width and height

Related topics

Elliptical Selection tool
Working with selection area



Magic Lamp

Effect determines the strength of the applied function
Level determines the function of the Magic Lamp

Related topic

Magic Lamp tool



Clone

Transparency allows you to control the transparency of the cloned area
Soft Edge blends the edge of the cloned area gradually with the background pixels in the painted 

image
Continue Drawing allows you to paint contiguous areas of the cloned image relative to the 

defined point

Related topics

Clone tool
Painting images
Selecting colors



Painting Tools

Factor provides three options which control which channels of the foreground/background color 
you paint on RGB True Color images

Soft edge makes the edges of your painted lines blend better with the underlying image

Related topics

Paintbrush tool
Airbrush tool
Line tool
Painting images
Selecting colors



Eraser

Erase Foreground to Background Color replaces only those pixels which are colored with the 
foreground color

Erase All Colors to Background Color changes all pixels to the background color

Related topic

Using the Eraser tool



Text

Text allows you to type the text you wish to enter on the image
Font contains all the available typefaces
Size displays the sizes available for the selected font
Sample allows you to view and change a sample character which display all the attributes you 

choose
User Defined Size allows you to enter a specific size for typefaces with vector screen fonts
Anti-Aliasing smoothes the curves of the characters (only for RGB True Color and Grayscale 

images)
Style lists the different styles that text can be produced in
Shadow allows you to create a 3-D text effect (the amount of shadow is determined by the values 

entered in the text boxes)
Color lets you specify the colors for the text and text shadow (disabled for Black & White and 

Indexed-Color images)

Related topic

Using the text tool



Select Color

Color Model offers the choice of RGB or HSB
New previews the color that will replace the current (old) color
Old displays the color you wish to edit
Slider Bars define the color components of the new color

Note: If you have tried all the options to select colors, you may have noticed that when a dialog box 
appears, it is always the same. The only thing that differs is the title bar. Regardless of what color you 
want to change, whether foreground, background, or cell color (for Indexed-Color images), the basic 
method for selecting a color is the same.

Related topics

Selecting color
Color Table dialog box



Select Shape

Brush Shape displays the current shape and allows you to select one of the six available shapes
Brush Size shows the size of the brush in pixels

Related topic

Painting images



Convert to Grayscale

Cell Size defines the size of the cell used to convert the black and white pixels of a Black & White 
image to shades of gray

Scale Down defines how much the image will be scaled down

Related topic

Converting images



Convert to Black & White

Resolution options:
Display defines the resolution of the new Black & White image to that of your display
Current Image defines the resolution of the new image to be the same as that of the active 

image
Printer defines the resolution as that of the printer selected in the Printer Setup dialog box
User Defined allows you to define your own resolution

Dither options:
None does simple grayscale value mapping to translate original gray shades into black or white
Pattern arranges pixels in patterns which simulate gray shades
Diffusion uses a less structured method of dithering than that used by the Pattern option

Note: When converting to Black & White, original variations in tone cannot be shown or represented in 
the new image. To simulate tones with only black and white pixels you may choose to dither them.

Related topic

Converting images



Convert to Indexed 16-Color (from Grayscale)

Dither options:
None does not dither the image
Pattern arranges pixels in patterns to simulate the grays that are not in the color table
Diffusion uses a less structured method to dither grays not found in the color table

Related topic

Converting images



Convert to Indexed 16-Color (from RGB True Color)

Palette options:
Standard uses the system's default 16-Color table
Optimized creates a color table that is the closest adaptation of the colors used in the image
Reserve Entries allows you to reserve some entries in an optimized palette

Dither options:
None does not dither the image
Pattern arranges pixels in patterns to simulate the grays that are not in the color table
Diffusion uses a less structured method to dither grays not found in the color table

Related topic

Converting images



Convert to Indexed 256-Color

Palette options:
3-3-2 (bits) uses the system's default 256-Color (8-bit) table
6-7-6 (levels) gives a palette which offers six shades of red, seven shades of green and six 

shades of blue
6-6-6 (levels) gives the most balanced use of the color palette
Optimized creates a color table that matches the range of colors used in the image as closely as 

possible

Dither options:
None does not dither the image
Pattern arranges pixels in patterns to simulate the grays that are not in the color table
Diffusion uses a less structured method to dither grays not found in the color table

Related topic

Converting images



Create Group

New Group Directory allows you to enter a directory for the new group created
Free Space indicates the amount of disk space available in the drive specified in New Group 

Directory
New Group Name allows you to enter a name for the group you create (up to 10 characters)

Related topics

Object Pool
The Object Pool window



Import Group

File Name shows the OPG extension or a selected filename; if you know the path and filename of 
the group you wish to load, enter it here or select it from the list box

List Files of Type lists the file extensions for object groups
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Browse opens the Browse dialog box, use this dialog box to search for object groups
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)

Related topics

Object Pool
The Object Pool window



Object Pool Information

Group Number indicates the number of groups in the Object Pool
Total Space Used indicates the space used on disk by the groups
Compress Object compresses the object when you drag to the Object Pool
Object Group Information gives information about a group selected in the group list box: 

number of images and masks, disk space used, group identification number, last time an object was 
added or deleted, and the working directory

Related topics

Object Pool
The Object Pool window



Browse



cgm



dxf



pcd



pic



bmp



eps



iff



jpeg



psd



ras



tga



tif



Restore
Replaces the current version of the image with the last saved version.

This command is useful if you save your files regularly. If you haven't saved your image file for a while 
you may lose work as all your changes will be discarded.



Save
Updates the last saved version of the image.

When you select this command for an image that has not been previously saved, the Save As dialog 
box appears.

Related topic

Save As dialog box



Acquire
Selecting the Acquire command displays a dialog box which varies according to the image input device 
you have installed.

If you select the Acquire command and you do not have a TWAIN data source or proprietary scanner 
device driver installed nothing will happen. If you do have a TWAIN data source or proprietary scanner 
device driver but it is incorrectly installed, a dialog box appears containing installation options.



Source: Select
Selects the TWAIN data source or proprietary scanner device driver you wish to use.

Related topic

Select Source dialog box



Source: Auto Tone Adjustment
Automatically adjusts the midtones and remaps newly input images onto the full range of available 
colors, improving contrast in the image.

Related topic

Auto Tone Adjustment dialog box



Source: Scan to Printer
If you choose this command, Image Editor opens the Print dialog box where you can set up print 
options. When you click OK, a check mark appears near the command, and the scanned images are 
automatically printed. Choose the command again to deselect this option.



Preferences: Image Editor
Allows you to customize some of the features of Image Editor.

Related topic

Image Editor dialog box



Preferences: OLE & Clipboard
Allows you to set options for OLE operations and to reduce the amount of memory used when copying 
selections onto the clipboard.

Related topic

OLE & Clipboard dialog box



Preferences: PhotoCD
Allows you to set the options for an image in PCD format (developed by Kodak for its PhotoCD products 
and supports Grayscale, Indexed 256-Color, and RGB True Color images).

Related topic

PhotoCD Open Options dialog box



Preferences: Display
Allows you to customize the display settings.

Related topic

Display dialog box



Preferences: Memory
Allows you to allocate additional working space.

Related topic

Memory dialog box



Preferences: File Formats
Allows you to choose the file formats you want to use.

Related topic

File Formats dialog box



Printer Setup
Please see your Windows documentation or Windows on-line Help for more information about this 
command.



Recent Files List
Contains the filenames of the most recently opened images. The full path of each file appears in the 
status bar when you select it. Simply click or choose a name in the list to open the image.



Undo
Reverses the effect of the last applied command (if possible). If you need to undo all your unsaved 
changes, restore or reopen the image to return to the last saved version.



Cut
Deletes an image or selected area and transfers it onto the clipboard.

The removed area is filled with the current background color. If no area is selected, Cut is applied to the 
whole image.



Copy
Duplicates an image or selected area onto the clipboard.



Paste As Selection
Pastes the clipboard contents as a floating selection in the upper left corner of the visible area, or of a 
selected area. If the selected area is outside the visible area, Image Editor automatically scrolls the 
image.

The Paste command is disabled if the clipboard is empty, or if the contents of the clipboard is from an 
incompatible Windows application that cannot be pasted into Image Editor images.



Paste Into Selection
Pastes the clipboard contents into a previously made selection.

This function is only available if you selected an area in your active image. If the selected area is 
outside the visible area, Image Editor automatically scrolls the image.

If the selected area is smaller than the clipboard image, the clipboard image will be cropped. Drag the 
pasted area around with a selection tool to choose which part of the image will be cropped.



Clear
Replaces an image or selected area with the current background color.



Clipboard: Load
Places an image onto the clipboard.

Similar to the Open command, but rather than opening a file and placing it in a new image window, the 
image file is placed onto the clipboard.

Related topic

Load File dialog box



Clipboard: Save
Saves the existing clipboard image to disk.

Related topic

Save File dialog box



Clipboard: Display
Displays the current clipboard image.

When you select this command, a clipboard window containing the image appears (the image fits in the 
window if possible). Click a mouse button, or press any key to close this window.



Select: None
Deselects any currently selected area.

If the selected area is floating, it is combined with the underlying image.



Select: All
Selects a whole image.



Select: Make Floating
Makes the current selection floating.

If Preserve image under selection, in the Preferences: Image Editor dialog box, is not selected, the area 
under the current selection is filled with the background color.



Select: Invert
Deselects the currently selected area and selects the area that was not selected.

Use this command when you want to protect a small area from an editing function. Select the small 
area with a selection tool and then choose "Select: Invert". The small area is deselected, the rest of the 
image becomes selected and available to Image Editor's tools and commands..



Select: Border
Allows you to select a line around the current selection area.

Related topic

Border dialog box



Select: Similar
Expands a selection to include areas that contain pixels with similar gray/color values.

Related topic

Similar dialog box



Select: Discard Floating
Removes a floating selection from the active image.

This command is enabled when you create a floating selection. Applying this command removes the 
floating selection without affecting the underlying image.



Crop
Trims the edges of the active image to retain only the selected area.

Areas outside the selected area, which remain within the image after cropping, are filled with the 
background color.

Related topic

Cropping the edges from an image



Fill
Fills an image or selection area with the current foreground or background color or clipboard data. You 
can also define a gradient fill.

Related topic

Fill dialog box



Tone Mapper
Corrects the gray/color values in an image by altering the curve that represents the brightness values of 
pixels.

Related topic

Tone Mapper dialog box



Invert
Reverses the brightness and color in an image.

If your image has shades of black, they are inverted to reflect shades of white. For images with colors, 
each pixel changes to its complementary color (e.g. blue will change to yellow). If you want to return to 
your original image, use the Undo command or apply the Invert command again.



Optimize
Redistributes pixel values across the full range of gray/color values.

When you select this command, Image Editor redraws the active image with a more evenly distributed 
range of gray/color values. The effect varies from one image to another, depending on the original 
distribution of pixel values. Generally, optimizing makes detail in the darker shadow areas more 
apparent.



Black & White
When you convert images to black and white, none of the original colors or gray shades can be shown 
or represented in the new image. To simulate them with only black and white pixels, you may choose to 
dither (halftone) the original color or gray values.

Related topic

Convert to Black & White dialog box



Grayscale
All conversions from Black & White are the same. Black & White images retain the least amount of 
information, so converting to any other data type makes more colors or shades of gray available. To 
make use of these shades, Image Editor can average areas (cells) of black and white pixels together to 
produce different gray shades. The larger the cell, the more gray shades the converted image contains.

Related topic

Convert from Black & White dialog box



Indexed 256-Color
When you convert an RGB True Color image to Indexed 256-Color, you are converting thousands or 
even millions of colors to 256. To get the most effective result, you need to decide how the 256 colors 
are chosen and how they are arranged (dithered) to simulate the original colors.

Related topic

Convert to Indexed 256-Color dialog box



RGB True Color
This data type contains 256 shades of red, green and blue. When you mix all of these together you find 
16.7 million possible colors. Hence the term True Color. This data type retains the most information and 
flexibility.



Grayscale to Indexed 16-Color
When you convert from Grayscale to Indexed 16-Color, Image Editor uses the 16 grays that most 
closely match the range of grays in the Grayscale image. The Dither options allow you to choose how 
Image Editor converts the missing gray shades to the 16 available ones.

If your active image is Grayscale and you select the Indexed 16-Color command in the Convert menu, 
the Convert to Indexed 16-Color dialog box appears.

Related topic

Convert to Indexed 16-Color (from Grayscale) dialog box



RGB True Color to Indexed 16-Color
When you convert from RGB True Color to Indexed 16-Color, you are converting a possible 16.7 million 
colors to only 16. To get the most effective result, you need to decide how the 16 colors are chosen and 
how they are arranged (dithered) to simulate the millions of colors from the original.

Select the Indexed 16-Color command in the Convert menu to display the Convert to Indexed 16-Color 
dialog box,

Related topic

Convert to Indexed 16-Color (from RGB True Color) dialog box



Duplicate
Creates a new untitled window containing a copy of the active image.

After creating a duplicate image, it becomes the active image. You can create as many duplicate 
images as your system memory allows. Duplicate images are not on disk until you save them, so if you 
want to keep a duplicate, remember to save it.



Blur
Reduces the contrast between adjacent pixels to create a softer image.

Images can be blurred in three different ways: Slightly, More, and Heavily. These functions follow the 
same procedure for calculating pixel values but create different effects in the image.



Sharpen
Increases the contrast at the interface between light and dark areas in an image.

Images can be sharpened with three degrees of increasing effect: Slightly, More, and Strongly.



Despeckle
Compares pixels with their neighbors, and changes the ones which stand out.

If you apply this filter to images with low contrast, or no areas of outstanding colors, it may not have any 
effect. To other images, it will clear up individual pixels and blend small areas of outstanding colors with 
the background. Larger areas of color have their edges softened.



Emphasize Edges
Outlines the edges of an image and increases the contrast along the edges, making them harder and 
more sharply defined.

An edge is defined as the part of an image where a significant change in color or brightness occurs.



Adjust for NTSC
Shows the image as it would appear on a TV screen.

When an RGB image is transferred to an NTSC (National Television Standards Committee) device, the 
colors are mapped to a different color model. Some colors of the image may change in the process. 
This command uses RGB color to simulate the mapping result. (Only available for RGB True Color 
images).



Special Effects
Allows you to perform special effects and apply filters on an image or a selected area (only for RGB 
True Color and Grayscale images).

Related topic

Special Effects dialog box



Warping
Places a grid on an image or selected area. By moving the points at the intersection of the grid lines 
you create curves and produce a distortion effect (only for RGB True Color and Grayscale images).

Related topic

Warping dialog box



Find Edges
Outlines the edges in an image and marks them with lines.

The color of the lines will vary depending on the image format you are working on. Grayscale images 
will produce lines of white and varying shades of gray. RGB True Color images will produce either white 
or colored lines.



Rotate: Left 90 degrees
Rotates an image or selected area 90 degrees counterclockwise.

Related topic

Rotating images



Rotate: Right 90 degrees
Rotates an image or selected area 90 degrees clockwise.

Related topic

Rotating images



Rotate: 180 degrees
Rotates an image or selected area 180 degrees.

Related topic

Rotating images



Rotate: Freely
Allows you define the rotation of a selected area by dragging.

Related topic

Rotating images



Rotate: Degree
Lets you specify the angle and direction to rotate an image or selected area.

Related topics

Rotating images
Rotate dialog box



Rotate: By Horizontal line
Allows you to define a line in the active image which is then rotated to become horizontal.

Related topic

Rotating images



Rotate: By Vertical line
Allows you to define a line in the active image which is then rotated to become vertical.

Related topic

Rotating images



Flip
Allows you to mirror all or part of an image horizontally or vertically. If no area of the image is selected, 
the entire image is flipped.



Set as Wallpaper
Allows you to create a custom wallpaper.

You can use any bitmap (file with a .BMP extension), and choose the Tile option (repeats the bitmap to 
cover the desktop) or the Center option (places the bitmap in the center of the screen).

To remove a wallpaper, use the Desktop dialog box and select None. You can access this dialog box by 
double-clicking on the Desktop icon in your Windows Control Panel window. Please see your Windows 
documentation or Windows on-line Help for more information about wallpapers.



Add a View
Creates a new window containing an additional view of the active image.

Up to eight views of a single image can be displayed at one time in separate windows. Edits made in 
any window are displayed in the other views.



Full Screen
Displays the image without any border, palettes, title bar, or menu bar.

To return to normal screen mode, press the ESC key.



Actual view
Shows the active image with each image pixel displayed by one screen pixel.

This is the normal (1x) view of an image; when you open images they are displayed either at their 
actual view or reduced to fit in a window.



Zoom In
Magnifies the view of the active image.

Zoom In to work on small details in an image. You can zoom in from 2x to 8x.



Zoom Out
Reduces the view of the active image.

Zoom out to view large images and compare several images. You can zoom out from 1/2x to 1/8x.



Fit in Window
Displays the whole of the active image to fit in a window. All the unavailable options are grayed out.



Image Information
Displays a dialog box containing information about the active image.



System Information
Displays a dialog box containing information about Windows, your disk, and current memory usage.



Color Table
Displays the color look-up table for Indexed-Color images.

Related topic

Color Table dialog box



Hide/Show Toolbar
Hides or shows the toolbar on the left of the Image Editor window.

Related topic

Toolbar



Hide/Show Color Palette
Hides or shows the color palette on the right of the Image Editor window.

Related topic

Color Palette



Hide/Show Status Bar
Hides or shows the status bar along the bottom of the Image Editor window.

Related topic

Status Bar



Hide/Show Global Viewer
Hides or shows the Global Viewer window.

Related topic

Global Viewer



Hide/Show Object Pool
Hides or shows the Object Pool window.

Related topic

Object Pool Window



Hide/Show Rulers
Hides or shows the rulers in the image window.

Note: The unit of measure used by the ruler is determined by the unit of measure selected in the 
Preferences: Image Editor dialog box. The intersection of the ruler contains a letter to indicate the unit 
of measure being used: P for pixel, I for inch, and C for centimeter.



Cascade
Stacks open windows so that the title bars are visible.



Tile
Resizes all open windows to the same size and arranges them to fill the workspace.



Arrange Icons
Arranges all minimized icons along the bottom of the workspace.



Windows List
Contains the titles of all windows currently in the workspace.



Contents
Starts Help and displays the topics in the Image Editor Help



Search for Help on
Opens the Search dialog box containing keywords from the Help topics



Glossary
Definitions of terms used by ImagePals programs and documentation.



Index
A complete listing of topics covered in Image Editor help.



Tips & Techniques
Advice on how you can use Image Editor more efficiently.



Technical Support
How to contact Ulead Systems when you have questions.



How to Use Help
Accesses the Windows guide to using Microsoft Help



About Image Editor
Displays the Image Editor product information box



About Ulead Products
Displays information about other products from Ulead System, Inc.



The image to be created can be Black & White, Grayscale, Indexed 16-Color, Indexed 256-Color or 
RGB True Color.



There are four options for the size of the new image:
Standard list box gives choices for standard display sizes.
Active Image creates an image with the same size as the active image. This is disabled if there 

are no open images.
Current Clipboard creates an image the same size as the image on the clipboard. If there is no 

image on the clipboard, this option is disabled.
User Defined allows you to define your own image size. The unit of measure for this option is the 

setting selected in the Preferences: Image Editor dialog box.



If the size is in pixels, the resolution determines the image's physical size.



The border is centered on the selection marquee, i.e. half the specified width is on the inside of the 
marquee and half on the outside.



For RGB True Color images there are three options:
HSB combines all channels with the underlying image: if the transparency is set at 0%, the 

floating selection completely replaces the underlying image.
Hue and Saturation merges the colors in the floating selection with the underlying image. Use 

this option to colorize gray areas in an image.
Hue Only merges only the hue of the floating selection with the underlying image. Use this option 

to change the color of areas in an image.



0% makes the floating selection completely replace the underlying image; the higher the value, the 
greater the transparency of the floating selection; at 50% the floating selection and underlying image 
merge equally.



The value determines the width of the area, at the edge of the floating selection, that will be blended. 
The pixels at the very edge of the area will have high transparency, while those further in will have 
gradually decreasing transparency. This is a non-linear function centered on a line of pixels so the value 
must be an odd number: 3, 5, 7, 9, or 11.



After clicking OK, you will see the effect of your adjustments but the floating selection is not part of the 
image until you deselect it. Before that, you can move it, discard it, or even change the Merge Control 
settings.



Only images currently open with the same image type in the workspace are available.



A negative value makes the two images overlap with the transparency setting controlling the merging in 
the overlap area. A positive value introduces space between the two images; this space is filled with the 
current background color. The unit of measure depends on your selection in the Preferences dialog box.



0% causes the floating image to obscure the active image in the overlap area; 100% causes the active 
image to obscure the floating image; 50% causes the two images to be equally blended. Images only 
overlap if the Distance value is negative.



The Image Editor window reappears as it was before stitching with an additional untitled window 
containing the newly stitched image. Double-clicking on one of the images has the same effect.



Use the Zoom In command to view a magnified portion of the two images to enable you to stitch more 
accurately.



Use the Zoom Out command to view a larger or reduced area of the two images to enable you to stitch 
more accurately over a longer stitch line.



To achieve the best result, the floating image must be placed within thirty pixels (either way) of its final 
destination.



This value should be slightly greater than the distance the floating image needs to move (horizontally or 
vertically) to align with the active image.



This value should be as close as possible to the extent of the overlap. The chosen overlap range is 
shown on the active image by a line. This line should go through the features in the active image which 
are duplicated on the edge of the floating image. If the overlap is too small (less than thirty pixels), the 
chance of a successful match is greatly reduced.



While you are placing the floating image, use a transparency of 50%, enabling you to see both images 
equally. Before you stitch, choose another transparency which will define how the area of overlap 
appears after stitching. 0% causes the floating image to obscure the active image in the area of overlap 
to be blended. 100% causes the active image to obscure the floating image.



When this option is not selected, the image can be distorted by adjusting either the width or height 
disproportionately. This results in the image being stretched horizontally or vertically.



The Unit combo box allows you to choose between resampling to a percentage of the original size, or to 
a physical size. The unit of measure is set in the Preferences: Image Editor dialog box.



Images on the clipboard can be used to fill the area. If the area is larger than the contents of the 
clipboard, the data is repeated to fill the area. If the area is smaller, the clipboard image is cropped.



Causes the clipboard image's top left corner to be placed on the top left corner of the selected area (or 
top left corner of the bounding box of a non-rectangular selection area). When not selected, the first 
copy of the clipboard image is pasted in the top left corner of the image; subsequent copies are tiled to 
the right and below until the image or selected area is filled.



This option is not available for Indexed-Color and Black & White images. If you select it, the Gradient 
Fill Style options become available. When you press OK the pointer changes shape and you can 
choose the foreground and background color in the Color Palette.

To quit the Fill mode, you can press the Esc key, click the right mouse button, or select any tool in the 
toolbar or any command in the menu bar.



The colors are laid perpendicular to the line. You define the position and length of the line by clicking 
and dragging the mouse.



You define the center point when you click on the image, and the dimensions of the fill shapes as you 
drag the mouse.

Press the Shift key to constrain the shape to a square or to a circle.



The left side of the histogram represents black; the right represents white or a solid color (red, green, or 
blue if they are chosen in the Channel list box). The diagonal line from bottom left to top right shows the 
function being applied to the image values.



Dragging to the right (a positive percentage) expands the highlights, dragging to the left ( a negative 
percentage) decreases the highlights, making the whole image appear darker.



This is a way of adjusting the midtones without affecting the highlights and shadows too much. You will 
notice that the function line becomes a curve when this function is applied. Drag to the right to lighten 
the midtones or to the left to darken them.



Makes shadows lighter or deeper. To make the shadows lighter drag the slider to the right. To make 
them deeper drag the slider to the left.



Use this if you need to see the distribution of light pixels in a dark image, or vice versa.



Use this to adjust the red, green, and blue channels individually. The Master option applies adjustments 
equally to each of the channels.



This is a standard way to ensure you are making full use of the color or grayscale capabilities of your 
image data type. This button is not available if the active image already uses the full range of tones 
available from black to white.



Hue distinguishes one color from another. Adjusting the hue angle shifts the colors in the image in 
relation to the hue circle.



Saturation describes the purity of the colors. A negative saturation value (dragging to the left) washes 
out the colors in an image until they become completely gray. A positive value (dragging to the right) 
makes the colors more intense.



Value can be from -100% to +100%. Negative values darken the midtones, positive values lighten them. 
Select a value of 0 if you only want to remap the image to use the full range of colors available.



When you click on a pixel, all neighboring pixels that come within the defined range are selected.
A value of 0 selects neighboring pixels only if they are exactly the same gray or color
255 selects pixels of all colors and grays, so the whole image will be selected
50 selects neighboring pixels that have values which differ from the pixel you clicked on by plus 

or minus 50. If you click on a pixel with values R25, G60, B190, neighboring pixels with values between 
R0 and R75, G10 and G110, and B140 and B240 will also be selected



If this option is not selected, the area is defined from corner to corner.



In the text boxes, enter the width and height of the area you want to select.



The Blur and Sharpen options are similar to the respective commands in the Effect menu; Lighten and 
Darken are similar to the Brightness control also found in the Image menu; Smudge (drags colors or 
grays from one area into another) has no equivalent command.



The higher the effect value, the greater the visible effect. For Blur and Sharpen the three values are 
equivalent to the different Blur and Sharpen commands available in the Effect menu.



For RGB True Color images the options are:
HSB replaces any existing color with the foreground color.
Hue and Saturation replaces the original hue and saturation values of pixels with those of the 

applied color. The original brightness values are retained. Use this option to tint Grayscale images (after 
converting them to RGB True Color).

Hue only replaces the original hue values of pixels with the hue value of the applied color. The 
original brightness and saturation values are retained. Use this option to subtly change "colors" in a color 
image to remove color casts and achieve special effects.



The amount of text entered is limited by the size of the text box, To start a new line press CTRL + Enter 
(or CTRL + M). You can also paste text into the text box from the Windows clipboard by pressing CTRL 
+ V.



For typefaces with bitmap screen fonts, the range of sizes will be limited to the bitmap sizes you have 
available.

The font size is specified by points (1/72 inch), so the real font size is also affected by the resolution of 
the active image.



When you are running an outline front interpreter (such as ATM), for typefaces with outline printer fonts 
resident on your hard disk, the size is specified relative to the resolution of your display.



The range of sizes is 1 to 24. To change the brush size, click on the arrows or enter a number directly 
into the spin box.



There are two ways to move a selection:
Click inside the selected area with any of the selection tools and drag it to another position in the 

same image or drag-and-drop it into another image. The selection now becomes floating. The effect on 
the underlying image in the original position of the area depends on the setting of "Preserve image under 
selection" in the Preferences: Image Editor dialog box.

Click inside the selected area with the Move tool and drag the selection marquee to another 
position. Only the selection marquee is moved.



    Magic Wand
The Magic Wand selects adjacent pixels in an image of similar colors or grays.

Double-clicking on the Magic Wand icon in the toolbar displays the Magic Wand dialog box.

Note: To select additional areas of an image, or to expand an existing area, make your initial selection 
and then, with the Shift key held down, select another area of the image. If you want to exclude an area 
from an already selected area, hold the Ctrl key down and select the unwanted area. The marquee will 
then no longer contain that area.

Related topic

Magic Wand dialog box



    Freehand Selection
There are two ways to use the Freehand Selection tool:

Click and drag the Freehand Selection tool and double-click to end.
Repeatedly click and release the mouse button at different points in the image to create a series 

of straight line segments. Double-click to end.

Note: To select additional areas of an image, or to expand an existing area, make your initial selection 
and then, with the Shift key held down, select another area of the image. If you want to exclude an area 
from an already selected area, hold the Ctrl key down and select the unwanted area. The marquee will 
then no longer contain that area.



    Rectangular Selection
The Rectangular Selection tool selects a rectangular area in an image.

To select additional areas of an image, or to expand an existing area, make your initial selection and 
then, with the Shift key held down, select another area of the image. If you want to exclude an area 
from an already selected area, hold the Ctrl key down and select the unwanted area. The marquee will 
then no longer contain that area.

Double-clicking on the Rectangular Selection icon in the toolbar displays the Select Area dialog box.

Related topic

Select Area dialog box



    Elliptical Selection
The Elliptical Selection tool selects an elliptical area in an image.

To select additional areas of an image, or to expand an existing area, make your initial selection and 
then, with the Shift key held down, select another area of the image. If you want to exclude an area 
from an already selected area, hold the Ctrl key down and select the unwanted area. The marquee will 
then no longer contain that area.

Double-clicking on the Elliptical Selection icon in the toolbar displays the Select Area dialog box.

Related topic

Select Area dialog box



    Move Selection
The Move Selection tool moves only the selection marquee.

If you use the Move tool when the selection area is floating, the contents of the area combines with the 
image.



    Eyedropper
The Eyedropper uses the left mouse button to select a new foreground color, and the right mouse 
button to select a new background color. Click somewhere in the active image or in the color palette to 
select the color of the pixel under the tool. This tool also displays the color value of pixels it passes over 
in the left corner of the status line.

Double-clicking on the Eyedropper tool displays the Select Color dialog box.

Related topic

Select Color dialog box



    Magic Lamp
The Magic Lamp is not strictly a painting tool, it performs several functions: blur, sharpen, lighten, 
darken, and smudge. Select the current function and the power of the effect in the Magic Lamp dialog 
box that appears when you double-click on the Magic Lamp icon in the toolbar.

This tool is only available for use in Grayscale and RGB True Color images. It utilizes either the square 
or round brush shape (if another shape is selected the function uses the square shape of the same 
size).

Related topic

Magic Lamp dialog box



    Zoom
To zoom in, simply click on the image. You can also drag the Zoom tool to define a rectangular area to 
be magnified: the zoom level depends on the ratio between the size of the area and the size of the 
image.

To zoom out hold the shift key and click on the image. To go back to the actual size, click once on the 
image with the right mouse button, or double-click on the Zoom icon in the toolbar.



    Clone
The Clone tool allows you to "clone" an area in an image and then "paint" the cloned area into the same 
image or another image open on the workspace.

Position the cursor in the center of the area you want to clone, press Shift and click once. A blinking 
cross-hair appears. Move the pointer to the area where you want to start painting and start to paint by 
dragging the mouse around. Image data from around the defined point will appear wherever you paint 
it.

This tool is only available for use in Grayscale and RGB True Color images. It utilizes either the square 
or round brush shape (if another shape is selected the function uses the square shape of the same 
size).

Double-clicking on the Clone icon in the toolbar opens the Clone dialog box.

Related topics

Clone dialog box
Select Shape dialog box



    Paintbrush
The Paintbrush applies dots of the foreground or background color.

Click the left mouse button to use the foreground color, the right mouse button to use the background 
color. The dots are the shape and size of the current brush. If you drag the paintbrush around, you draw 
a freehand line. You can set the brush size and shape by clicking on the Brush Shape button (on top of 
the Color palette).

Double-clicking on the Paintbrush icon in the toolbar opens the Paintbrush dialog box.

Related topics

Painting Tools dialog box
Select Shape dialog box



    Airbrush
The Airbrush produces a sprayed area of the foreground or background color.

Hold down the left mouse button to use the foreground color, the right mouse button to use the 
background color. The color applied with the Airbrush gradually builds up as you drag it back and forth 
over a point. You can set the brush size and shape by clicking on the Brush Shape button (on top of the 
Color palette).

Double-click on the Airbrush icon in the toolbar to display the Airbrush dialog box.

Related topics

Painting Tools dialog box
Select shape dialog box



    Line
The Line tool allows you to draw straight lines in an image.

Hold down the left mouse button to use the foreground color, the right mouse button to use the 
background color. You can set the brush size and shape by clicking on the Brush Shape button (on top 
of the Color palette). Press the shift key while drawing a line to constrain it to an angle of 0, 45, or 90 
degrees.

Double-clicking on the Line icon in the toolbar displays the Line dialog box.

Related topics

Painting Tools dialog box
Select shape dialog box



    Text
The Text tool allows you to enter any text into an image in a variety of fonts and styles. You can also 
create text with a 3-D effect:

1. Click on the Text tool icon in the toolbar.
2. Click on an area in the image where you want the text to start. The Text dialog box appears.
3. Enter the text to insert in the Text entry field at the top of the dialog box.
4. Select the font, size and style for the text. Set shadow and color effects as desired.
5. Click OK. The dialog box closes and the text appears on the image as a floating selection filled with 

the selected color. The Rectangular selection tool is automatically selected.
6. Move the text to the desired position. To combine the text with the image, click on the right mouse 

button and select None.

Related topic

Text dialog box



    Eraser
The Eraser tool allows you to replace areas of an image with the current background color. You can 
choose to replace everything it passes over or just the foreground color.

1. Choose the color you want to change as the foreground color and the replacement color as the 
background color.

2. Double-click on the Eraser tool in the toolbar to display the Eraser dialog box.
3. Select "Erase foreground to background color" and click OK to close the dialog box and return to the 

image.
4. Click in the image and drag the eraser across an area in the image which contains some foreground 

color. The foreground color in the area changes to the background color without affecting any other 
colors.

Related topic

Eraser dialog box



    Brush Shape button
Displays the current brush shape.

Click once on the button to open the Select Shape dialog box, where you can choose a different brush 
shape, and define the size of the brush.

    Brush Size slider
Shows the current brush size in pixels.

It can also be used to quickly adjust the current size of the brush. Simply drag the slider indicator up or 
down to define a new size.

Related topic
Select Shape dialog box



Color Panel

Contains the colors that can be 
applied to the image. The 
contents of the palette depends 
on the data type of the active 
image. Click on a color to choose 
it. (For RGB True Color images, 
you can display a continuous 
spectrum of color or colors in 
discrete cells by clicking on the 
button below the color panel).



    Color indicators
Display the current foreground and background colors. The gray border indicates which color is active: 
the Color Value sliders below indicate its value.

Click the left mouse button on an image or on the color panel to select the foreground color, and the 
right mouse button to select the background color. Double-click on one of the squares to display the 
Select Color dialog box where you can modify its color.

Related topic
Select Color dialog box



    Color Value sliders 

Display the RGB or HSB color value (as chosen in the Select Color dialog box) of the active color 
square in the Color indicator. The active square is surrounded by a gray border: click on a square to 
make it active.

You can adjust the color by dragging the slider indicators up or down. For Indexed color and Grayscale 
images, the sliders automatically adjust to the nearest color defined in the color panel.

Related topic
Select Color dialog box



Filenames can be entered with or without a file extension. If no extension is entered, the extension 
selected in the List Files of Type list box is automatically added.



Filenames can be entered with or without a file extension. If no extension is entered, the PAL extension 
is automatically added.



Within this list box, you can select multiple files by dragging down the list and by using the SHIFT and 
CTRL keys in conjunction with the mouse.



Scaling maintains the aspect ratio of the image. When this option is not selected, the image prints at the 
size determined by its resolution.



If neither of these is selected, images print starting from the top left corner. If both are selected, the 
image is centered on the page.



Position is relative to the top left corner of the printable area of the page. These options are disabled 
when you select the corresponding centering option or Scale to fit the page.



The default shape, Round, is the most commonly used. Other shapes can be used to achieve particular 
effects.



The default angle, 45° is the most commonly used for black and white output.



The default, 53 lpi, is calculated to give you a near-optimum result on a 300 dpi printer. For lower 
resolution printers, use the default or a frequency between 30 lpi and 50 lpi; for other medium resolution 
printers, use the default or a frequency between 50 lpi and 80 lpi; and for high resolution printers 
choose a frequency between 90 lpi and 150 lpi.



When this option is not chosen, and you move or transform a selected area, the original position of the 
selected area is filled with the background color. With this option selected, moving or transforming a 
selected area has no effect on the underlying image.



This option retains in memory the status of an image immediately prior to a change made to it. After 
making a change, you may recover the previous state by selecting "Undo" from the Edit menu.

Disabling this option frees memory used by the Undo command. You may find performance is slightly 
faster but changes are irreversible.



This option defines the background color of the objects in the Object Pool, and the sample images in 
the Special Effects, Warping and Custom Filter when the image or selected area is not rectangular.

For images with dark colors, choose Light Gray as background color to have a better view.



When converting, the higher the number, the more shades of gray will be introduced and the smoother 
the transitions of tone in the image will be. For line-art images, use a cell size of one. For a photo 
scanned with a black and white hand-held scanner, choose a cell size from three to eight (depending on 
the settings of the scanner). If the result of this command shows visible grids in the image, the cell size 
is not correct. Undo the conversion and try a different cell size.



A scale-down value of one results in no scaling. A scale-down value of two reduces the width in pixels, 
height in pixels, and resolution of the image by half.



If you have a high resolution printer selected, this will produce a very large (in memory) Black & White 
image and the conversion may take a long time.



The shown unit of measure is dependent on the unit chosen in the Preferences: Image Editor dialog 
box.



This option tends to result in sharp transitions between black and white in the image.



This option generally results in the most accurate conversion.



This option uses the gray in the color table that is closest to the gray being converted. This tends to 
result in sharp transitions between shades of gray in the image.



This option generally results in the most accurate conversion.



This color table contains the 16 colors displayable on a CGA or EGA display device. This option is 
useful when you transfer Image Editor images to other Windows applications, or when you need to 
ensure that the same color table is used for all images, e.g. as when creating images for an animation 
sequence to be generated in another application.



If your RGB True Color image only contains green and blue and you select the optimized option, the 
resulting color table will be made up primarily of the colors that appear in the image (that is, green and 
blue). Because the colors in most images are concentrated in particular areas of the color spectrum, the 
Optimized option normally gives the best conversion.



For example, If your image is largely green and blue, you may not have any black in the image, but you 
may need black to add text at a later time. Select the Reserve Entries: Black & White option and the 
color table will contain greens, blues, black and white. The 8 Prime colors are red, green, blue, cyan, 
magenta, yellow, black, and white.



Does not dither the image. Instead, the color in the table that is closest to the color under analysis is 
used. This tends to result in sharp transitions between shades of color in the image.



Uses a less structured method to dither colors than the method used with the Pattern option to dither 
colors. Diffusion generally results in the most accurate conversion.



This color table is based on an arrangement of eight (3-bit) reds, eight (3-bit) greens, and four (2-bit) 
blues.



This is the standard palette used by ZSoft Paintbrush IV Plus.



This palette offers six levels (shades) of red, six levels of green, and six levels of blue. This is the 
standard palette used by the Apple Macintosh computer.



If your RGB True Color image contains green and blue and you select the optimized option, the 
resulting color table is made up primarily of colors that appear in the image (green and blue). Since 
colors in most images are concentrated in particular areas of the color spectrum, this option normally 
provides the most accurate conversion.



The following operations can be applied to several images at once: Close, Close Quickly, Minimize, 
Print, Resolution, Restore Window, Save, and Save to Album.

Close Quickly closes selected files without saving any changes. This command is unique to the Batch 
Manager.



Smoothes an image or selected area by averaging each pixel's original value with the original values of 
the surrounding pixels.

Square size determines the size of the cells from which average values are taken. You specify the 
number of pixels each pixel is averaged with to create smoother contours in the image. The default 
value is 2.



Moves the brighter pixels in an image or selected area horizontally. Similar to Windy, but the wind trail 
does not fade away.

Direction applies the effect to the left or to the right.

Moving Offset defines the length of the wind trail. The default value is 20.

Note: This effect is not available for Grayscale images.



Increases the number of levels displayed by the blue or cyan pixels in an image or selected area.

Level defines the intensity of the effect. The default value is 5.

Note: This effect is not available for Grayscale images.



Makes an image or selected area appear to be stamped or raised from paper of a particular color.

Color lets you use the foreground or the background color. Using gray creates an image that appears 
to be stamped in metal.

Depth defines how much the image will be embossed. A positive value makes the image elements 
appear raised above the background. A negative value makes the image elements appear sunken. The 
default value is 1.



Breaks an image or selected area into rectangular strips of random size that are moved around in a 
random order. (Similar to raindrops on a window.)

Square Size defines the size of each squares in pixels. The default value is 20.

Shift Value changes the random equation. The default value is 10.



Fat stretches an image or selected area out to the side, expanding the center of the image. Thin 
squeezes the image in from the side, reducing the center of the image.

Level defines the intensity of the effect. The default value is 5.



Shifts the center part of an image or selected area toward the edges. The center of the image appears 
expanded.

Refraction rate defines the intensity of the effect: a low value applies faint distortion, a high value 
applies a more pronounced distortion. The default value is 5.



Creates an effect similar to taking a picture of a moving object.

Angle determines the angle of the motion. The default value is 0.

Moving Offset defines the intensity of the motion effect in pixels. The default value is 2.



Breaks an image or selected area into blocks consisting of pixels of the same gray/color value.

Square Size defines the size of each block in pixels: the value for each block is taken from the average 
of the original pixel values contained within each block. The default value is 2.



Breaks an image or selected area into puzzle-like squares. The space between the squares is filled with 
the current background color.

Square Size defines the size of each block in pixels. The default value is 20.



Melts and distorts an image or selected area horizontally.

Direction applies the effect to the left or to the right.

Note: This effect is not available for Grayscale images.



Breaks an image or selected area into square blocks. Unlike the Puzzle effect, the blocks move 
independently and overlap. The space between the squares is filled with the current background color.

Square Size defines the size of each block in pixels. The default value is 20.

Shift Value defines the position of the blocks: a low value keeps the blocks in a grid; a higher value 
shifts the blocks randomly. The default value is 10.



Increases the number of levels displayed by the red or yellow pixels in an image or selected area.

Level defines the intensity of the effect. The default value is 5.

Note: This effect is not available for Grayscale images.



Gives the impression that an image or selected area has been painted with water colors.

Stroke size applies small or large brush strokes.

Moisture Level defines the amount of "water" mixed with the color. A high level makes the edges of 
each stroke darker.

Note: This effect is not available for Grayscale images.



Moves the brighter pixels in an image or selected area horizontally, like Motion Blur. Similar to Blast, but 
the wind trails gradually fades away.

Direction applies the effect to the left or to the right.

Moving Offset defines the length of the wind trail. The default value is 20

Note: This effect is not available for Grayscale images.



Click and drag the control points at the intersection of the lines. If Show Control Points is unchecked, 
click right at the intersection of the lines, a point will appear under your pointer.

Each point can be moved across one square in each direction. For a stronger effect, choose the large 
grid size.



Choose the finer grid to create precise curves. Choose the larger grid to produce very strong 
distortions.



Choose the Good option to apply the effect faster. The Better option is slower, but produces a smoother 
distortion.



The cell at the center of the matrix is the pixel whose value is to be regenerated. The other cells 
represent the surrounding pixels. New pixel values are generated as follows:
1. The matrix is placed on the image with the pixel in question at the center.
2. Image Editor multiplies the value of each pixel in the matrix by the value from the corresponding cell. 

The sum of the new values is then calculated.
3. The resulting sum is divided by the Divided by value, and the Offset value is added to the result.
4. The new value is saved.
5. The cell then moves one pixel on, to regenerate the next pixel's value.
6. This is repeated until all pixel values have been regenerated.



You can choose one of four options:
No allows you to independently enter values in cells
Horizontal automatically repeats, in the horizontally opposite cell, a value you enter in the matrix
Vertical automatically repeats, in the vertically opposite cell, a value you enter in the matrix.
4-Way automatically repeats, in the horizontally, vertically, and diagonally opposite cell, a value 

you enter in the matrix.



The mapping curve that runs across the Map shows the actual brightness values for the pixels at each 
point across the map. The horizontal axis graphs the original (input) gray/color values, with the values 
of 0 (black) to 255 (white). The vertical axis graphs the new (output) values.



Drag the handles to adjust just a portion of the mapping curve (a limited range of gray/color values) at a 
time.



Image Editor compares the differences in gray/color values between the pixels in the current selection 
and the unselected parts of the image. If the pixels in the unselected parts of the image fall within the 
specified color range, they will be selected. The selection area will expand until it meets pixels outside 
of the defined grayscale/color range.



The first line displays the data type of the file, and if it is compressed or not. The second line shows the 
size in pixels, and the resolution of the image. The last line shows the size occupied on disk, and the 
date and time of the last modification of the file.



Before you select this option you should test your display card to see if it is compatible with the 
Compatibility test provided.



When you press this button, the color squares on the right become squares of different grays, if your 
card is compatible. If your card is incompatible, nothing will happen or you will have to restart your 
computer.



This option is available if you are using a 256-Color display. This is an important option if you want to 
view Grayscale images at the same time as color images on a 256-Color display, or compare any sort 
of image on a 256-Color display.



This affects the speed of display updating on 256-Color displays. When selected, Image Editor only 
updates the active image. Images in the background may appear distorted, blurred, or grayed. The 
content of the background images is not changed, only the way they are displayed. If you wish to 
compare two or more images, deselect this option.



Use this feature to display images correctly on all types of computer display. When this option is 
disabled, or set to 1.00, the display of images is not adjusted.



This option is enabled only when the display mode is 256 colors.

Some application cannot convert true color images effectively and correctly. Select this option to help 
the conversion process.



If you use OLE operations, it is highly recommended to leave this option unchecked. If you check this 
option, Image Editor performs delayed rendering for RGB True Color images. This may lead an OLE 
client to use the DDB format as the data of the linked object, which causes the saved document of the 
client to be large.



0% causes the cloned area to completely replace the painted area; 50% causes the two areas to be 
equally merged; 100% has no visible effect on the painted image, as the cloned area is totally 
transparent.



When this option is not selected, you start painting from the defined point each time you click the mouse 
button. Use this option if:

you want to clone a large area in an image, as you can release the mouse button to check your 
work, or to change the clone or brush settings

you want to reproduce two or more areas relative to each other without painting the area between 
them



If you drag an image object onto the workspace, an untitled window with the current background color is 
created. The object appears as a floating selection.

If you drag a mask object, an untitled Grayscale window is created.



When you bring an image or a selected area into the Object Pool, it remembers its original position 
based on the size of the image. This means that if you drag an object back into the image it was cut 
from, the floating selection appears at its original position when you release the mouse pointer 
anywhere in the image. If the image's size has changed, the floating selection appears where you 
release the mouse pointer.



The cursor changes to an "F" stamp. The image or selection is filled with the image object, starting from 
the upper left corner.



Every group you create has a three digit identification number, starting from 00, the Default group 
created by the Object Pool when you first use the Object Pool.



Object Type menu
You can store selections as images or as masks. Selections are called objects and appear as 
thumbnails in the Object Pool window.

The third option, Store Image as Mask, is only available for Grayscale images, and allows you to store 
images as masks.

You can also access those commands by pressing the arrow button next to the Object Pool icon, below 
the Color Palette.



Object Type menu
You can store selections as images or as masks.

The third option, Store Image as Mask, is only available for Grayscale image, and allows you to store 
images as masks.



When you store a selection as an image, the Object Pool saves two files: an image file, and a mask file.

In the Object Pool working directory (specified in the Create Group dialog box), the image file appears 
under the name oi01-001.tif, and the mask file under the name ok01-001, 01 being the ID number of the 
group, and 001 the ID number of the object.



When you store a selection as a mask, the Object Pool saves it under the name om01-001.tif in the 
Object Pool working directory (specified in the Create Group dialog box). 01 is the ID number of the 
group, 001 the ID number of the object.



Group Menu
Create Group allows you to create a new group
Delete Group allows you to delete the current group
Import Group allows you to import a group previously saved on disk
Delete object deletes the currently selected image(s) or mask(s) (use Ctrl or Shift to select 

multiple objects)
Information displays information about the Object Pool



This feature is useful if you want to share groups on a network.
when you are using a group, nobody can access it. If you press the Lock button, the group 

becomes available to other users, but only as read-only
the Lock button cannot be released if more than one user accesses the group
if you try to open the Object Pool and all the groups are locked, a warning message appears



 Using Image Editor

Image Editor basics
Working with images
Working with selection areas
Inputting images
Converting images
Object Linking & Embedding
Using Drag-and-Drop
Object Pool
Global Viewer



 Image Editor basics

Creating a new image
Opening an image
Finding files
Saving an image
Printing an image
Closing an image
Exiting Image Editor
Calibrating your display
Using the Batch Manager
Getting information



 Working with images

Painting images
Selecting colors
Adjusting image values
Changing the resolution of an image
Resampling an image
Cropping the edges of an image
Flipping images or selections
Rotating images
Joining image strips
Creating customized filters



 Working with selection areas

Selections are shown by an animated dotted line around the edge of the selected area. This dotted line 
is called the selection marquee. The marquee may be selecting part of an image, or floating and 
containing part of any image.

Creating selection areas
Deselecting a selection
Moving selection areas
Merging a selection area
Resizing selection areas
Slanting selection areas
Distorting selection areas
Working with masks



 Getting information

When working with images, you can get information about:

Images, choose "Image Information" from the View menu.
Your system, choose "System Information" from the View menu.



 Calibrating your display

Calibrate your display before you start working with images for the first time. Recalibrate whenever you 
change your monitor, display adapter, or the environment in which you work.

The lighting of your work area and the brightness and contrast settings of your monitor all affect the way 
images are displayed. Try to keep these variables as constant as possible to ensure that images display 
consistently and accurately. To calibrate your display:

1. Choose "Preferences: Display" from the File menu. The Display dialog box appears.
2. Make sure the Monitor gamma check box is unchecked.
3. Click OK and the dialog box closes.
4. Choose "Open" from the File menu to display the Open dialog box.
5. Open the file IPGAMMA.TIF. You should be able to find this file in your Pals2 directory or on the 

installation disks. The IPGAMMA.TIF image appears.
6. Look at this image and identify the gray square that best matches the vertical, gray background 

band. Make a note of the number displayed next to this square. If for example, the square at the 
bottom of the middle row looks most like the background, take a note of the number 1.7.
This number can be any value from 0.01 to 7.99. If none of the squares exactly match, you should 
estimate the best match.

7. Choose "Preferences: Display" from the File menu. The Display dialog box appears.
8. Click on the Monitor gamma check box and, in the text box, type the number you noted in step 6. 

Click OK. The Preferences dialog box closes.

Related topic

Display dialog box



 Using the Batch Manager

Use the Batch Manager command from the File menu to apply a command to multiple images in a 
single operation. The commands available through the Batch Manager are: Close, Close Quickly, 
Minimize, Print, Resolution, Restore Window, Save and Save to Album.

Simply select an operation, select some images, and then press OK. Image Editor does the rest for you.

Related topic

Batch Manager dialog box



 Inputting images

Image Editor allows you to input images from a variety of sources. Until recently only photographs, 
illustrations, and other image or graphic components could be brought into the desktop. These were 
most commonly obtained via image scanners. Now, once you have the required hardware and software 
drivers, a much wider range of sources are available.

The images which are not yet on your disk may be accessed using the following commands:

Select Source Submenu
Import Submenu

Related topic

TWAIN commands



    TWAIN commands

TWAIN is an industry standard that allows applications to use image input devices without any complex 
installation. It has been described as "providing seamless connection between applications and 
devices".

If you have a TWAIN-compatible device you should follow the installation procedure provided to you. 
Once installed, you will be able to use it from Image Editor or any other application that supports TWAIN 
without worrying about compatibility problems. The TWAIN commands can be found in the File menu.

Select Source displays the Select Source dialog box
Acquire accesses the software driver for the device selected in the Select Source dialog box



 Import Submenu

The Import submenu in the File menu gives you access to external software modules which expand 
Image Editor's ability to acquire image files in special formats or from new devices. The commands that 
appear in this submenu depend on your currently installed modules. These modules are normally 
associated with some hardware: if you do not have the hardware, you will be unable to use the module.

When you first install ImagePals you have the choice of installing several modules. If you do not have 
the appropriate hardware and choose not to install them, then your Import submenu will be empty. To 
install the modules later, run the ImagePals Setup program and select to install Import/Export modules. 
If the module you require is not listed, select "Others" from the list of available modules. Installation is 
automatic after inserting the driver disk containing the module file and an OEM.INF file.

Related topic

Export submenu



    Export submenu

Accesses export software modules to print to special printers or export images in specialist formats. 
These modules are supplied by hardware or software manufacturers to enhance the compatibility of 
Image Editor with their product.

To install a new module, run the ImagePals Setup program and select to install Import/Export modules.

Related topic

Import submenu



 Creating a new image

Use the New command from the File menu to create an image filled with the current background color 
in a new window. You can create an "empty" image into which you can paste elements from other 
images to form a new, composite image.

1. Choose "New" to display the New dialog box.
2. In the Data Type drop-down list box, choose the data type of the new image.
3. Select an image size.
4. Enter a value for the resolution.
5. Click OK. The dialog box closes and creates a new untitled image filled with the current background 

color.

Note: When you choose an image size in centimeters or inches, the resolution determines how many 
pixels are used to create the image: higher resolutions require more memory.

When you define the size in pixels, the resolution determines how large your image will be when 
printed. The higher the resolution, the smaller your image will print (the memory required to store the 
image remains the same).

Related topics

New dialog box
Supported Image Data Types



 Opening an image

Use the Open command from the File Menu to open files from your hard disk, floppy disk, or network 
drive.

1. Choose "Open" to display the Open dialog box.
2. Select the appropriate file extension from the List Files of Type list box.
3. Locate the directory or drive containing the file using the Directories and Drives list boxes.
4. Click on the appropriate filename in the File Name list box.
5. Click on the Preview button to preview the image before opening.
6. Click OK. The dialog box closes and the image appears in your workspace.

Related topics

Open dialog box
Supported File Formats



 Finding files

There is a Browse button in all dialog boxes which involve opening or accessing files on disk. Use this 
button as follows:

1. Click on the Browse button to display the Browse dialog box.
2. Use the Directories and Drives list boxes to access the drive and directory you want to browse.
3. Click on the Scan button. This searches the path you have specified for files with a name matching 

that in the File Name text box. Matching files are then listed in the files found list box.
4. Select the file you want to open from the files found list box by clicking on it.
5. Click OK to return to the original dialog box. The file name and path you found appear in the File 

Name text box.

Related topic

Browse dialog box



 Saving an image

Use the Save As command from the File menu to save a file for the first time. When saving you can 
choose the file format to save your image in and, if a compression option is available, whether or not to 
compress it.

1. Choose "Save As" to display the Save As dialog box.
2. From the Directories and Drives list boxes, choose the drive and directory to which you want to save 

the active image.
3. Select a format from the List Files of Type list box.
4. In the File Name text box, type the name of your file (up to eight characters). You do not need to 

enter the file extension.
5. Click OK to return to the window containing your saved image.

Related topics

Save As dialog box
Supported File Formats



 Printing an image

Use the Print command from the File menu to print images to any Windows-compatible output device. 
Select your printer with the Printer Setup command.

1. Choose "Print" to display the Print Image dialog box.
2. Decide how many copies you want to print and type it in the Copies text box.
3. Decide where you want the image to print on the page by making the necessary entries or clicking 

on the available options.
4. Click OK to print the image.

Related topic

Print dialog box



 Closing an image

You can close the active image window by:

double-clicking on the window's control menu box.
clicking on the window's control menu box and choosing "Close".
choosing the Close command in the File menu.
if the image is minimized, clicking once on the icon and selecting the Close command from the 

menu which appears.
displaying the Batch Manager dialog box, selecting the name of the images to close and choosing 

the Close or Close Quickly operation.

When you close modified or unsaved images, a message appears containing the file name of the image 
and inquires if you want to save it to a disk file. Click on Yes to save the changes, No to disregard them.

Related topic

Batch Manager dialog box



 Exiting Image Editor

Use the Exit command from the File menu to exit Image Editor. You can also exit by:

double-clicking on the application control menu box.
clicking on the application control menu box and choosing "Close".
if Image Editor is minimized, clicking once on the icon and selecting the Close command from the 

menu which appears.



 Changing the resolution of an image

Use the Resolution command from the Image menu to determine the physical size of an image. You 
may want to change the resolution of an image before you print it. You can resize an image without 
actually changing the number of pixels in the image.

1. Choose "Resolution" to display the Resolution dialog box.
2. Choose the resolution you want to use: Display, Printer, or User defined. If you choose User defined, 

enter a new resolution in the text box.
3. Click OK to change the resolution of the active image. There is no change in the appearance of the 

image in Image Editor.

Related topic

Resolution dialog box



 Cropping the edges of an image

Use the Crop command from the Edit menu to trim the edges of an image. The edges cropped from 
your image cannot be retrieved again unless you immediately undo the Crop command.

1. Use one of the selection tools to select the area of the image you wish to retain.
2. Choose "Crop" to discard the areas outside the selection marquee. Only the area you have selected 

is retained.

Note: If you select a non-rectangular area, the image is cropped to the smallest rectangle that can 
contain the selected area. Areas outside the selected area, within the new image, are filled with the 
current background color.



 Resampling an image

Use the Resample command from the Image menu to change the size and proportion of an image; 
images can be almost any size.

1. Choose "Resample" to display the Resample dialog box which contains information about the 
current width and height of the image.

2. Enter the new width and height for the image.
3. Click on the Keep Aspect Ratio check box to maintain the proportions of the active image. If you 

enter the width, the height is automatically generated; if you enter the height, the width is generated.
4. Click OK. A new image appears with the new width and height you specified.

Note: If you enter a new width and height of 100%, the active image is duplicated.

Related topic

Resample dialog box



 Adjusting image values

Use the Tone Adjustment, Brightness & Contrast, Hue & Saturation, and Level Adjustment commands 
from the Image menu to adjust image values.

These commands operate in a similar manner and can be applied to selected areas or, if there is no 
current selection, to the whole image. However, some of the commands are not applicable to some data 
types, or they cannot be applied to a selected area in certain data types.

1. Select the area for which you want to make corrections or adjustments. If no area is selected, the 
changes are applied to the entire image.

2. Choose "Tone Adjustment", "Brightness & Contrast", "Hue & Saturation", or "Level Adjustment" to 
display the appropriate dialog box.

3. Adjust the options by dragging the slider indicators along the slider bar. If necessary, preview your 
changes by pressing the Preview button.

4. After enhancing the image, click OK to apply your changes.

Related topics

Tone Adjustment dialog box
Brightness & Contrast dialog box
Hue & Saturation dialog box
Level Adjustment dialog box
The Preview button



 The Preview button

The Tone Mapper, Tone Adjustment, Brightness & Contrast, Hue & Saturation, and Level Adjustment 
dialog boxes all provide a preview button. This button allows you to preview the effects without affecting 
the image. You can continue adjusting if the effect doesn't satisfy you.

If your display adapter has a color lookup table, Image Editor can simulate the adjustments you make 
by using a color palette animation technique. However, the whole image will reflect the enhancements 
as they occur even if you are only enhancing a selected area. To preview an effect on a selected area, 
leaving the rest of the image unchanged, use the Preview button.

Using the Preview button disables color animation. To re-enable the animation, hold down the Shift key 
and click on Preview.



 Converting images

Converting an image creates a new window containing a version of the original image in a new data 
type. The title bar of the new window contains the name of the original file without the file extension.

Not all image types can be converted directly to every other image type. When a conversion is not 
available for a particular image, that data type is disabled in the Convert submenu. The available 
conversion paths are listed in the table below.

Image Type Can convert to :

--------------------------------------------------------------------

Black & White Grayscale 
Grayscale Black & White

Indexed 16-Color
Indexed 256-Color
RGB True Color

Indexed 16-Color Grayscale
RGB True Color

Indexed 256-Color Grayscale
RGB True Color

RGB True Color Grayscale
Indexed 16-Color
Indexed 256-Color

Related topics

Supported Image Data Types
Convert Submenu



 Painting images

Image Editor's painting tools enable you to apply colors to images. The painting tools include 
Paintbrush, Clone, Airbrush, Eraser, and the Line tool. The effects painting tools have on the current 
image depend on the current brush shape, size, the current foreground and background colors, and the 
individual tool options.
You can manipulate the effects of the painting tools by:

Double-clicking on the painting tool icon in the toolbar and defining its options.
Setting the brush size and shape by clicking on the Brush Shape button above the Color Palette.
Selecting the colors to apply to the image.

Related topics

Painting Tools dialog box
Clone dialog box
Eraser dialog box



 Creating selection areas

Selection areas can be created and manipulated by the use of the selection tools and the selection 
commands from the Edit menu.

Magic Wand
Freehand Selection
Rectangular Selection
Elliptical Selection
Move Selection

The Select Submenu commands



 Deselecting a selection

Image selections, whether floating or not, remain selected until you deselect them. Once you deselect a 
selection, the marquee disappears and its contents are left where they are as part of the image. To 
deselect a selection you can:

click on the Rectangular or Elliptical Selection tools, then click once anywhere on the image 
outside the selection marquee

click on a selection tool, then press the right mouse button anywhere in the active image and 
choose None from the pop-up menu

choose "Select: None" from the Edit menu
double-click on the Freehand selection tool
press Ctrl + N



 Merging a selection area

Normally, when you deselect a floating selection, the floating selection completely replaces the portion 
of the underlying image below it. In many cases this may be desirable, but there will be times when you 
require greater control over the process. The Merge Control command gives you that control. It allows 
you to set the transparency of the floating area, how colors combine and the degree to which the edges 
of the selection area are blended with the underlying image.

1. Choose "Select: Merge Control" from the Edit menu to display the Merge Control dialog box.
2. Select a level of transparency and, if you wish, the amount of edge blending. For RGB True Color 

images, you can also select a factor to control color combination.
3. Click on the Preview button to view the effect of the current settings.
4. Click OK when you are satisfied with the result. The dialog box closes and the effect is applied to the 

floating selection. You can then move it to the right position before deselecting it.

Note: The Merge Control command works only on Grayscale and RGB True Color images. Its effect 
cannot be undone but you may redefine the settings or discard the floating selection without affecting 
the underlying image.

If you drag-and -drop a selection to another image, or save it as a mask, only the edge blending value is 
kept during copying.

Related topic

Merge Control dialog box



    Working with masks

Use the Select: Load and Save Mask commands from the Edit menu to load and save a selected area 
as a mask. Masks can be used to produce special effects and create composite images where joints 
and seams are invisible. Once you have saved a mask, you can reopen it and edit it as a Grayscale 
image, ready for the next time you want to load it back into an image.

1. Select the area you want to save as mask.
2. Choose "Save Mask" to display the Save Mask dialog box.
3. From the Directories and Drives list boxes, choose the drive and directory to which you want to save 

the mask.
4. Select a format from the List Files of Type list box (must accept Grayscale images).
5. In the File Name text box, type the name of your mask (up to eight characters). You do not need to 

enter the file extension.

To load a mask, choose "Select: Load Mask". The Load Mask dialog box is similar to the Open dialog 
box: once you open a mask, the selection marquee appears on the active image.

Note: When loading a mask, Image Editor places the mask in the top left corner of the visible area, or 
the current selection area, if there is a selection. If you move your selection area to the border of the 
image and its top left corner is not visible, it is possible that the whole loaded mask falls outside the 
image. In this case, the message "There's no selection or selection falls outside the image" appears. 
(This message appears also if all the gray values in the mask are lower than 127.)

Related topics

Load Mask dialog box
Save Mask dialog box



 Resizing selection areas

Use the Free Resize command from the Effect menu to make a selected area bigger or smaller.

1. Select the portion of the image you want to resize.
2. Choose "Free Resize". A box, with handles at each corner and on each side, appears around the 

selection.
3. Drag a handle to size the selected area. To resize two sides of the selection at the same time, drag a 

corner handle. The contents of the selected area are resized as you drag the handle. When you 
reach the desired size, release the mouse button.

4. To merge the resized portion with the image, select None in the Select submenu, or click once 
outside the selected area.

Note: Resizing a selected area with the Shift key held down maintains the original proportion of the 
area.



 Rotating images

The Rotate commands in the Effect menu contains options to rotate a selected area or a whole image. 
You can use them to rotate an image by a small amount or straighten images which have been scanned 
at an angle.

Below is a procedure showing how you can rotate images using the rotate by line options. If your image 
has strong horizontal elements, use "By Horizontal Line", if it has strong vertical elements, use "By 
Vertical Line". Both commands allow you to define a line which will then be rotated horizontally or 
vertically.

1. Make the image you want to straighten active.
2. Choose "By Horizontal line" or "By Vertical line" from the Rotate submenu in the Effect menu. A line, 

with a handle at each end, appears on the image.
3. Identify a horizontal or vertical element in the image and drag the closest handle to one end of this 

element.
4. Drag the other handle to the other end of the element so that the joining line aligns with the element.
5. Double-click on one of the handles. The image is rotated so that the chosen line becomes horizontal 

or vertical.

Related topic

Rotate Submenu



 Distorting selection areas

Use the Distort command from the Effect menu to stretch an image to any desired shape.

1. Select the portion of the image you want to distort.
2. Choose "Distort". A box with four handles, one at each corner, appears around the selected area.
3. Click and drag one of the handles in the direction you want to distort.
4. When you reach the desired degree of distortion, release the mouse button.
5. To merge the slanted portion with the image, select None in the Select submenu, or click once 

outside the selected area.

Note: Hold down the Shift key to drag handles without applying distortion every time. Then click on one 
of the handle.



 Slanting selection areas

Use the Slant command from the Effect menu to horizontally or vertically slant a selected portion of an 
image.

1. Select the portion of the image you want to slant.
2. Choose "Slant". A box with four handles, one at each corner, appears around the selected area.
3. Click and drag one of the handles in the direction you want to slant.
4. When you reach the desired degree of slant, release the mouse button.
5. To merge the slanted portion with the image, select None in the Select submenu, or click once 

outside the selected area.

Note: Slanting a selected area with the Shift key held down, moves a single handle of the area. To 
create a perspective effect, slant two adjacent corners of an area in opposite directions.



 Selecting colors

The color palette, on the right of the Image Editor workspace, contains all the colors you can apply to an 
image. The range of colors displayed is dependent on the type of the image you are currently working 
on.

Before you can apply a specific color, select it as the current foreground or background color. These 
colors are displayed in the current colors indicator. Use the left mouse button to select the foreground 
color, and the right mouse button to select the background color. You can change colors by:

double-clicking on the Eyedropper tool, or the background or foreground color square to display 
the Select Color dialog box.

clicking on any color in the color palette with the left or right mouse button.
clicking on and dragging the color value slider indicator. The active color is surrounded by a gray 

border.
using the Eyedropper tool to choose a color from either the color palette or the active image.

Related topic

Select Color dialog box



 Joining images using the Tile Two Images command

Use the Tile Two Images command from the Edit menu to create special effects or join two images 
when the joint is not critical. Special effects can include repeating an image by joining it to itself many 
times, or joining a flipped version of an image to the original to create a mirror effect.

1. Make one of the images you wish to join the active image by clicking on its title bar.
2. Choose "Tile Two Images" to display the Tile Two Images dialog box.
3. In the Floating image drop-down list box, choose the image you want to join to the active image.
4. Click on the direction arrows to choose the position of the floating image in relation to the active 

image (the floating image is shown with a shadow).
5. In the Distance text box, enter a negative value.

You may enter a positive value but then there will be a gap between the images. This gap is filled 
with the current background color.

6. In the Transparency text box, enter a value from 0 to 100% for the transparency of the floating image 
in the overlap area.

7. Click on OK and the dialog box closes. A new window containing the joined images appears. In the 
overlap area the images will have been blended.

Related topic

Tile Two Images dialog box



 Joining images using the Stitch command

Use the Stitch command from the Edit menu to join two parts of the same image as seamlessly as 
possible.

1. Make one of the images you wish to join the active image.
2. Choose "Stitch" to display the Stitch dialog box.
3. In the Floating image list box, choose the image you want to join to the active image. The chosen 

image becomes the floating image in the Stitch operation.
4. Click on the direction arrows to choose the position of the floating image in relation to the active 

image (the floating image is shown with a shadow).
5. Click on the Place button. Image Editor goes into Stitch mode. A new menu bar appears containing 

stitch commands and the two images are displayed in the workspace.
6. Drag the floating image until you are satisfied with its position. Choose Auto Fine Tune from the 

Option menu for precise adjustment.
7. Double-click on the image or select the Done command from the Action menu. A new window 

appears containing the stitched images.

Related topics

Stitch mode
Stitch options
Stitch dialog box
Auto Stitch Control dialog box



 Stitch mode

Image Editor enters the Stitch mode when you press the Place button in the Stitch dialog box. If you try 
to close this mode with the Close command in the control menu, you are actually trying to close Image 
Editor and a message, "Please complete the Image Editor operation first", appears. Press OK and, if 
you don't want to continue with the Stitch operation, choose Quit from the Action menu.

Action menu
Auto Stitch... opens the Auto Stitch Control dialog box where you can reposition the floating 

image to match the active image
Done joins the two images in their current positions and exits Stitch mode
Quit cancels the stitching operation, and restores the Image Editor window

View menu
Actual View displays the images at their normal (1x) view
Zoom In zooms in on the image 
Zoom Out zooms out on an image
Transparency... defines the transparency of the floating image in the area of overlap

Option menu
Auto Fine Tune automatically fine tunes the position of the floating image after you have dragged 

it or defined the matching points
Help! provides you direct access to this help

Related topic

Stitch options



 Joining image strips

If your scanner cannot scan a whole picture in one pass, you need to scan it more than once and then 
join the resulting images to form a complete picture. Most hand-held scanners can only scan areas up 
to about four inches wide. For these scanners, the ability to join images accurately is essential. Image 
Editor provides this function with the Tile Two Images and Stitch commands in the Edit menu.

With Image Editor you can only join images that are both Grayscale or RGB True Color. To join images 
of other data types, you must first convert them to Grayscale or RGB True Color. Following are two 
procedures which you can follow when joining image strips:

Using the Tile Two Images command
Using the Stitch command

Related topic

Tips for using a hand-held scanner



 Tips for using a hand-held scanner

If you are using a hand-held scanner, you should follow the following guidelines:

scan as slowly and as smoothly as possible.
if possible, run your scanner against a straight edge placed on your image. Mark the beginning 

and end of your image on the ruler and start scanning a little before the beginning. This ensures you scan 
the right portion of an image as straight as possible.

when scanning loose sheets or pages of books, make sure they are firmly secured and as flat as 
possible.

try to give yourself a bit of space above and below the image and mount the image flush with the 
surrounding surface. It is important that the hand-held scanner's runners are always in contact with the 
surface and they don't have to climb thick edges.

don't have excessively bright lights shinning directly on the image to be scanned.
keep the hand-held scanner clean, in particular, the runners and scanning window.



 Stitch options

The Place button in the Stitch dialog box allows you to enter the "Stitch" mode. In this mode, the Image 
Editor workspace is cleared to leave only the two images to be stitched and the menu bar is replaced by 
special Stitch menus. You then have the following stitch options:

drag the floating image until it is in the correct place, partially overlapping the active image.
define a point in each image, by holding the Shift key down and clicking first in one image and 

then in the other. Image Editor then aligns the images on these points.
choose "Auto Fine Tune" in the Option menu to aid the above two methods of manual stitching.
set auto-stitching parameters and let Image Editor automatically match and align the floating 

image on the active image.
set the transparency of the floating image to aid manual stitching and to define how images are 

combined in the overlap area.



 Object Linking & Embedding

Linking and embedding objects can vary from program to program. Before you do this, we suggest that 
you read your client program's documentation.

Basically there are two routes to embedding (one of which can also be used for linking). One starts from 
the client program, the other from the server. To embed objects starting from the:

Client
Server



 Embedding from the Client

To embed an object starting from the client:

1. Open or create a document in the client program and select the client's Insert Object command (or 
similar). The Insert Object dialog box appears.

2. In the Object type list box, select "Ulead Image Editor Image".
3. Click OK. The dialog box closes and Image Editor appears.
4. Open the image you want to embed.
5. From Image Editor's File menu, choose "Update client" (client is the name of the client program).
6. Either Exit Image Editor or switch to the client program. The object you selected appears in the 

active document in the client program's workspace.



 Embedding or linking from the server

To embed an object starting from the server:

1. Starting from Image Editor, open the image file you want to embed.
2. From the Edit menu, select "Copy".
3. Exit Image Editor and open the client program containing the document into which you want to place 

the object.
4. Select the client program's Paste Special command. The Paste Special dialog box appears.
5. In the Data Type list box, select "ImagePals Image Editor Image".
6. Click on Paste. The dialog box closes and the object is embedded in the client program's active 

document. (If you copied an image or selected part of an image that is saved on disk, the Paste Link 
button is available. Press this button to link the object rather than embed it.

Note: In some client programs, you can use their normal Paste command to embed an object.



 Dragging a selection into the Object Pool

When you drag a selection area to the Object Pool, you can decide to store it as a mask or an image in 
a group.
1. Use one of the selection tools to select an area in an image. Choose Select All in the Select 

submenu if you want to select the whole image.
2. Choose to store the selection as an image or a mask in the menu that appears when you click on the 

arrow button on the left of the Object Pool icon or in the Object Pool window.
3. Drag the selection into the Object Pool. You can drag it to the Object Pool window or to the Object 

Pool icon below the Color palette (in this case, the status bar lets you know which group is selected).
4. The selection appears as an object in the group.

Note: Hold down the "M" key to drag the selection as a mask (even when "Store Image" is selected)

Related topics

The Object Pool window
Working with selection areas



 Dragging an object from the Object Pool

With the objects stored in the Object Pool, you can:
Create new documents by simply dragging an object onto the workspace
Load an image object into an image by dragging it into an image on the workspace; it appears 

as a floating selection
Import a mask object into an image by dragging a mask into an image on the workspace; it 

appears as a static selection (the Move tool is automatically selected)
Create a pattern fill by pressing the "F" key and dragging an object to an image, or a previously 

selected area

Related topics

The Object Pool window
Working with selection areas



 Drag-and-drop operations

In Image Editor, you can use drag-and-drop to perform several tasks: create new images, copy and 
save images or selections, and create pattern fillings and masks.

You can drag images or selections directly from one document to another, or to the Object Pool, where 
you can store them for future use.

Drag-and-drop with no key held down:
Drag a selection area from one image to another, it appears as a floating selection
Drag a selection area to the workspace, it appears in a new untitled window
Drag a selection area to the Object Pool, it is stored as an image object

Drag-and-drop with "M" key held down
Drag a selection area from one image to another, it appears as a static mask (the Move tool is 

automatically selected)
Drag a selection area to the workspace, it appears in grayscale in a new untitled window
Drag a selection area to the Object Pool, it is stored as a mask object (overrides setting in Object 

Type menu)

Drag-and-drop holding down the "F" key
Drag a selection area to another image to fill it with a pattern (also available from the Object Pool)

Related topics

Working with selection areas
Object Pool



 Creating customized filters

Use the Custom Filter command from the Effect menu to create your own enhancing filters, e.g. Blur, 
Sharpen or special filters like Motion Blur. When you apply this filter to an image or selected area, each 
pixel's value is regenerated from its original value and the value of its surrounding pixels.

1. Choose Custom Filter to display the Custom Filter dialog box.
2. Choose one of the four options in the Symmetry list box.
3. Enter a value for each cell in the matrix (the value must be between -999 and 999).

The center of the matrix is placed on each pixel in an image (or selected area) and the values in 
the cells are applied to the pixels under the matrix to generate a new value for the pixel at the center.
4. Enter values into the Divided by and Offset text box. All the pixel values are divided by the first 
value, with the Offset value added on after.
5. Check the Invert option if you want to invert the gray/color values of the image or selected area 
after the value of the target pixel has been generated.

Related topic

Custom Filter dialog box
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Converting images

Convert to Black & White dialog box
Convert to Grayscale dialog box 
Convert to Indexed 16-Color dialog box (Grayscale)
Convert to Indexed 16-Color dialog box (RGB True Color)
Convert to Indexed 256-Color dialog box
Converting images
Converting to Indexed 16-Color

Copy
Create Group dialog box
Creating a new image
Crop

Crop
Cropping the edges of an image

Custom Filters
Creating customized filters
Custom Filter dialog box
Load Custom Filter dialog box
Save Custom Filter dialog box

Cut

D

Despeckle
Display

Calibrating your display
Clipboard: Display
Display dialog box

Distorting selection areas
Drag-and-drop

Drag-and-drop operations
Dragging a selection into the Object Pool
Dragging an object from the Object Pool

Duplicate

E

Edges
Cropping the edges of an image
Emphasize Edges
Find Edges

Edit menu
Editing

Adjusting image values
Changing the resolution of an image
Converting images
Cropping the edges of an image
Painting images
Resampling an image
The Preview button
Using the Batch Manager

Effect Menu



Elliptical Selection
Elliptical Selection dialog box
Elliptical Selection tool

Embedding
Embedding from the client
Embedding from the server
How to link and embed objects

Emphasize Edges
Eraser

Eraser dialog box
Eraser tool

Exiting
Export submenu
Eyedropper tool

F

File menu
Fill

Fill
Fill dialog box

Filters
Blur
Creating customized filters
Despeckle
Sharpen
Special Effects

Find Edges
Finding files
Fit in Window
Flip
Freehand Selection tool
Full Screen

G

Global Viewer
Global Viewer
Hide/Show Global Viewer

Grayscale
Convert to Grayscale dialog box 
Grayscale
Grayscale to Indexed 16-Color

H

Halftone dialog box
Help

Help menu
Search for Help on

Hue & Saturation dialog box

I

Image Editor basics
Image Editor dialog box
Image Information
Image menu
Image values



Adjusting image values
Brightness & Contrast dialog box
Hue & Saturation dialog box
Level Adjustment dialog box
Tone Adjustment dialog box
Tone Mapper dialog box

Import
Import Group dialog box
Import submenu
Inputting images
Tips when using a hand-held scanner
TWAIN commands

Indexed 16-Color
Convert to Indexed 16-Color dialog box (Grayscale)
Convert to Indexed 16-Color dialog box (RGB True Color)

Indexed 256-Color
Indexed 256-Color
Convert to Indexed 256-Color dialog box

Information
Getting information
Image Information
Object Pool Information dialog box
System Information

Inputting
Export submenu
Import submenu
Inputting images
Tips when using a hand-held scanner
TWAIN commands

Invert
Invert
Select: Invert

J

Joining
Joining image strips
Joining images using the Stitch command
Joining images using the Tile Two Images command
Stitch Options

K

L

Level Adjustment dialog box
Line tool
Linking

Embedding from the client
Embedding from the server
How to link and embed objects

Load Color Table File dialog box
Load Custom Filter dialog box
Load File to Clipboard dialog box
Load Tone Map dialog box

M



Magic Lamp
Magic Lamp dialog box
Magic Lamp tool

Magic Wand
Magic Wand dialog box
Magic Wand tool

Map file
Load Tone Map dialog box
Save Tone Map dialog box
Tone Mapper dialog box

Masks
Load Mask dialog box
Save Mask dialog box
Working wih masks

MeMemory dialog box
Menus

Clipboard submenu
Convert submenu
Edit menu
Effect Menu
File menu
Help menu
Image menu
Menu commands
Option submenu
Pals menu
Paste submenu
Preferences submenu
Rotate submenu
Select submenu
Source submenu
View menu
Window menu
Windows control menu

Merge Control
Merge Control dialog box
Merging a selection area

Move Selection tool

N

New
Creating a new image

NTSC
Adjust for NTSC

O

Object Pool
Create Group dialog box
Drag-and-drop operations
Dragging a selection into the Object Pool
Dragging an object from the Object Pool
Hide/Show Object Pool
Import Group dialog box
Object Pool Information dialog box
Object Pool Window



Object Pool
Object Type menu

OLE
Embedding from the Client
Embedding from the server
How to link and embed objects
OLE & Clipboard dialog box

Open
Open dialog box
Opening an image

Optimize
Option submenu

P

Paint tools
Airbrush tool
Clone dialog box
Clone tool
Eraser dialog box
Eraser tool
Line tool
Magic Lamp dialog box
Magic Lamp tool
Paintbrush tool
Painting Tools dialog box

Paintbrush
Paintbrush tool
Painting Tools dialog box

Painting images
Pals menu
Paste

Paste submenu
Paste As Selection

Preferences
Calibrating your display
Display dialog box
Image Editor dialog box
OLE & Clipboard dialog box
Preferences submenu
Preferences: Image Editor

Preview button
Print

Print dialog box
Printer Setup
Printing an image

Q

R

Recent Files List
Rectangular Selection

Rectangular Selection dialog box
Rectangular Selection tool

Reference Information
Resample



Resample dialog box
Resampling an image
Resizing selection areas

Resolution
Changing the resolution of an image
Resolution dialog box

RGB True Color
RGB True Color
RGB True Color to Indexed 16-Color

Rotate
Rotate dialog box
Rotate submenu
Rotate: Left 90 degrees
Rotating images

Rulers
Hide/Show Rulers

S

Save
Clipboard: Save
Save As dialog box
Save Clipboard File dialog box
Save Color Table File dialog box
Save Custom Filter dialog box
Save Tone Map dialog box
Saving an image

Scan
Export submenu
Import submenu
Inputting images
Scan to Printer
Scan to Printer
Source: Auto Tone Adjustment
Source: Select
Tips when using a hand-held scanner
TWAIN commands

Select
Select Color dialog box
Select Shape dialog box
Select submenu
Select: All
Select: Border
Select: Discard Floating
Select: Invert
Select: Make Floating
Select: None
Select: Similar

Selection areas
Creating selection areas
Distorting selection areas
Dragging a selection into the Object Pool
Merging a selection area
Resizing selection areas
Select: All
Select: Border
Select: Discard Floating



Select: Invert
Select: Make Floating
Select: None
Select: Similar
Selecting colors
Slanting selection areas
Working wih masks
Working with selection areas

Selection tools
Elliptical Selection dialog box
Elliptical Selection tool
Freehand Selection tool
Magic Wand dialog box
Magic Wand tool
Move Selection tool
Rectangular Selection dialog box
Rectangular Selection tool

Shape
Select Shape dialog box

Sharpen
Shortcuts
Similar

Select: Similar
Similar dialog box

Slanting selection areas
Source

Select Source dialog box
Auto Tone Adjustment dialog box
Source: Select
Source: Auto Tone Adjustment
Scan to Printer
Source submenu

Special Effects
Special Effects dialog box
Special Effects
Warping dialog box
Warping

Status Bar
Hide/Show Status Bar
Status Bar

Stitch
Auto Stitch Control dialog box
Joining image strips
Joining images using the Stitch command
Joining images using the Tile Two Images command
Stitch dialog box
Stitch mode
Stitch mode
Stitch Options
Tile Two Images dialog box
Transparency dialog box

System Information

T

Technical Support
Text



Text dialog box
Text tool

Tile
Tile
Tile Two Images dialog box

Tips
Applying color to images
Controlling the view of images
Using the object pool
Working with files
Working with selections

Tone Adjustment dialog box
Tone Mapper

Tone Mapper
Tone Mapper dialog box

Toolbar
Hide/Show Toolbar
Toolbar

Tools
Airbrush tool
Brush Settings
Clone dialog box
Clone tool
Elliptical Selection dialog box
Elliptical Selection tool
Eraser dialog box
Eraser tool
Eyedropper tool
Freehand Selection tool
Line tool
Magic Lamp dialog box
Magic Lamp tool
Magic Wand dialog box
Magic Wand tool
Move Selection tool
Paintbrush tool
Painting Tools dialog box
Rectangular Selection dialog box
Rectangular Selection tool
Text dialog box
Text tool
Toolbar
Zoom tool

Transparency dialog box
TWAIN

Acquire
Export submenu
Import submenu
Inputting images
Select Source dialog box
TWAIN commands

U

Undo
Using the object pool



V

VGA Palette dialog box
View

Add a View
Full Screen
Actual View
Fit in Window
Zoom tool
View menu

W

Wallpaper
Set as Wallpaper

Warping
Warping
Warping dialog box

Window menu
Windows control menu
Windows List
Working with files
Working with images
Working with selections
Workspace elements

Color Palette
Global Viewer
Object Pool
Status Bar
Toolbar

X Y Z

Zoom
Fit in Window
Zoom In
Zoom tool



Image Editor tips & techniques

          Working with selections  
          Using the object pool  

Controlling the view of images
          Working with files  

Applying color to images



Working with selections

You can move the pointer with the direction keys. If you are creating a selection area, using the 
direction keys adjust the size of the selection marquee. To move a selection marquee once it has been 
created, first click on it with your mouse and then use the appropriate direction key.

Press the F3 key to remove a floating selection or pasted image.
Double-clicking on the freehand or move tools deselects a selection area.
If you make a mistake while drawing a selection area with the freehand selection tool, or wish to 

start again, press the Esc key.
Pressing F5 toggles the Preserve Image Under Selection option.
To copy one area of the image to another, make sure the Preserve Image Under Selection option 

in the Image Editor preferences dialog box is checked, then select the area you want to copy and then 
move it to its new location. 

Save system resources by selecting and dragging only the area you are working on to the 
workspace to create a new image and to the object pool as a mask. When you finish editing the image, 
drag the mask back to the original image and copy the edited image to the clipboard. Then paste the 
clipboard contents into the same position as the original image.



Using the object pool

Holding down the M key as you drop a selection into the object pool automatically saves it as a 
mask.

If you want to place a selection into the same position in other images, make sure the target 
images are the same size as the image the selection was originally created in.

Did you know that whenever you create an object, it is saved as a TIF file in the PATTERNS 
subdirectory? This allows you to perform file maintenance such as backing them up to another storage 
device.

Object files are easily identified with an O prefix followed by the letter I (image), K (image as 
mask), or M (mask), with a creation number at the end.You can compress these files by checking 
Compress Objects in the Object Pool Information dialog box.



Controlling the view of images

You can use the + and - keys to zoom in and out on images.
Dragging over an area of an image with the zoom tool selected automatically zooms in on that 

portion.
When scroll bars appear in the image window, you can use the these combinations to change the 

view of the image:
Ctrl + Home = move to the left edge
Ctrl + End = move to the right edge
Shift + Home = move to the top
Shift + Home = move to the bottom
Double-clicking on the zoom tool returns an image to actual view (1x).
The global viewer can be quickly accessed by clicking on the box at the intersection of any scroll 

bars.



Working with files

Check out a file before opening it by clicking on the Preview button at the bottom of the Open 
dialog box.

You can open several files consecutively by using the Shift key with your mouse to select a range 
of files. To select, or deselect individual files, use the Ctrl key. (You can also drag your mouse over the 
filenames to select them.)

If you want to save a large number of files quickly, use the Save command in the batch manager.
Use the Close Quickly command in the Batch Manager to quit Image Editor when many files are 

open and you don't want to save any of them.
Pressing the F6 key or double-clicking on the status bar opens the Image Editor preferences 

dialog box.
Use the Resolution command to change the size of an image without affecting the number of 

pixels and quality. 



Applying color to images

If you have the eyedropper tool selected, clicking on an image with the left mouse button selects 
that color as the foreground color, clicking the right mouse button selects it as the background color.

When using a painting tool, the left mouse button applies the current foreground color, the right 
mouse button, background.

A great way to remove unwanted colors from an image is to smudge them out using the smudge 
tool (see magic lamp). This blends the colors with those of the surrounding pixels.

If you want to change the color of a feature, such as an eye, but don't want to blot it out, select 
the Hue and Saturation option in the painting tool's options dialog box.

Use the clone tool to remove certain areas of an image and replace them with surrounding 
features or those from another image .

To remove a specific color from an image without affecting neighboring pixels select the color to 
be removed as the foreground color. Then using the eraser tool, select the Erase Foreground to 
Background Color option in the Options dialog box and drag over the area you want to erase.



Ulead ADK

 What is the ADK? 
 What can you do with the ADK? 
 What does the ADK contain  ?   
 Ordering Informatio  n   

Technical Support



What is the ADK?

The Ulead ADK is a set of sample programs with accompanying documentation. The documentation 
shows the application programming interface (API) calls supplied by Album and other Ulead programs. 
Other applications can call these APIs for access to Ulead program features such as reading and writing 
image data file. 

The ADK also shows sample programs for writing File Input/Output (FIO) and Media Input/Output (MIO) 
filters so Ulead products can access or catalog foreign file formats.

Related topics

What can you do with the ADK?
What does the ADK contain?
Ordering Information
Technical Support



What can you do with the ADK?

With ADK you can do the following:
Find existing IAC (Inter Application Compatible protocol) compatible programs to take advantage 

of existing MIO or FIO filters
Allow users to drag and drop files from your application into Album as thumbnails, and vice versa
Register your application as an IAC compatible program: you can insert thumbnails into albums 

when saving files and your application will be shown along with other Ulead products in the Switch menu. 
Create albums or insert thumbnails to albums for cataloging and browsing purposes.
Access a file format using existing FIO filters
Do file conversion using existing FIO filters.
Create new FIO filters for reading and writing specific multimedia file formats
Create new MIO filters for generating thumbnails and for cataloging specific multimedia file 

formats

Related topics

What is the ADK?
What does the ADK contain?
Ordering Information
Technical Support



What does the ADK contain?

The ADK consists of the following items:
Ulead ADK introduction
Ulead ADK document
Sample program diskette
License Notice and Distribution Agreement
Development Support Option
Suggestion Form
Order Form

Related topics

What is the ADK?
What can you do with the ADK?
Ordering Information
Technical Support



Ordering Information

This list shows the ADK packages and their per unit prices. All prices are in US dollars and subject to 
change without notice.

Base Produc  t:      $ 600
Base Product with Development suppor  t:      $ 2,100
Development Suppor  t:      $ 1,500
Shipping and Handling (Asia):    $ 35
Shipping and Handling (Worldwide):    $ 50
North and South American orders
International orders

Related topics

What is the ADK?
What can you do with the ADK?
What does the ADK contain?
Technical Support



Technical Support

If you have any questions or comments about this or any other Ulead products, we want to hear from you. 
Ulead has three offices to help you:

Before you call, please prepare the following information so we can offer you the best possible support:
The program name and serial number
Nature of the problem
Any error messages or dialog boxes that appear when the problem occurs
System information including the type CPU, your operating system, and any other programs 

running at the time the problem occurs.

If you decide to write or fax us, add printouts of the following:
AUTOEXEC.BAT
CONFIG.SYS
WIN.INI
ULEAD.INI

Note: You can obtain copies of these files quickly by running SYSEDIT.EXE in your Windows program 
directory.

In North and South America
Europe
International 



In North and South America

Our California offices are open Monday through Friday from 9:00 AM to 5:00 PM Pacific Standard Time.

Phone us at 
(310)-523-9393

Fax us at 
(310)-523-9399

Write to us at
Ulead Systems, Inc.
970 West 190th Street, Suite 520
Torrance, CA 90502

Call the Ulead BBS at
(310)-523-9389 19200 bps (N,8,1)

Or send EMail to
(MCI Link gateway on Internet)

ULead@mcimail.com 
(MCI Mail)

EMS: ULead / MCI ID: 522-0621
MBX: Support @ ultc 

(Compuserve)
101400,221 

(Internet)
ulead@c2.hinet.net 

-or-
idpt871@tpts1.seed.net.tw



International

Our international headquarters in Taiwan, R.O.C. has personnel fluent in English, French, German, and 
Chinese available to help. Office hours are Monday through Friday from 9:00 AM to 6:30 PM Taiwan time.

Phone us at 
+886 (2) 764-8599

Fax us at 
+886 (2) 764-9599

Write to us at
Ulead Systems, Inc.
12F-A, 563 Chung Hsiao E. Rd.,
Sec 4,
Taipei, Taiwan, R.O.C.

Call the Ulead BBS at
+886-2-764-7585 19200 bps (N,8,1)

Or send EMail to
(MCI Link gateway on Internet)

ULead@mcimail.com 
(MCI Mail)

EMS: ULead / MCI ID: 522-0621
MBX: Support @ ultc 

(Compuserve)
101400,221 

(Internet)
ulead@c2.hinet.net 

-or-
idpt871@tpts1.seed.net.tw



Europe

Our Customer SupportCenter in Germany is open Monday through Friday from 8:00 AM to 5:00 PM GMT.

Phone us at 
+49 6042-68472

Fax us at 
+49 6042-68575

Write to us at
Ulead Customer Support.
An der Saline 31
D-63654 Büdingen, BRD

Call the Ulead BBS at
+886-2-764-7585 19200 bps (N,8,1)

Or send EMail to
(MCI Link gateway on Internet)

ULead@mcimail.com 
(MCI Mail)

EMS: ULead / MCI ID: 522-0621
MBX: Support @ ultc 

(Compuserve)
101400,221 

(Internet)
ulead@c2.hinet.net 

-or-
idpt871@tpts1.seed.net.tw



The base product contains the ADK and access to public bulletins and messages on the Ulead BBS.



The base product with development support contains the ADK an complete technical support via fax, 
EMail, or BBS for sixty (60) days or twenty (20) hours, whichever comes first.



Development support offers extended technical support to those who already own the ADK via fax, E-
Mail, or BBS. Each contract covers sixty (60) days or twenty (20) hours, whichever comes first.




